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安全信息
将电源线连接到正确接地的电源插座上，所连接的电源插座与产品的距离不可太远，并且要符合使用方便的原
则。

请不要在水边或潮湿的地方放置或使用此产品。

请只使用随此产品提供的电源和电源线或厂商的认可替代品。

将此产品连接到公共交换电话网络时，请只使用随此产品提供的通信线缆（RJ-11）或者 26 AWG 或更高的替
代品。

本产品使用特定制造商的元件，并按照严格的世界安全标准来设计、测试及验证。有些零件的安全功能特征可
能不一定很明显。对于更换其他厂家零件所造成的不良后果，制造商概不负责。

当心—可能的伤害：双面打印部件后面的区域带有突出的棱角（纸张通道的一部分）。为了避免受伤，当
您为了清除卡纸而接触此区域时，请特别小心。

当心—可能的伤害：请不要切割、扭曲、捆绑、挤压电源线，或者在电源线上放置重物。请不要使电源线
磨损或受压。请不要将电源线塞在物体之间，例如家具和墙壁之间。如果发生了这些事情，可能会产生火
灾或电击危险。请定期检查电源线，及时发现这种问题的迹象。在检查电源线之前，请先从电源插座上断
开。

有关操作说明书中未提及的其他服务或维修，请向专业的服务人员咨询。

当心—电击危险：当清洁打印机的外部时，为避免受电击的危险，请在操作之前先从墙壁插座中拔掉电源
线并从打印机上断开所有电缆。

当心—电击危险：在雷雨天气时，请不要使用传真功能。也不要在雷雨天气时设置本产品，或者使用传真
功能、电源线或电话线进行带电操作或线缆连接。

请保留这些安全指导。

安全信息

7



关于您的打印机

感谢您选择此打印机！
我们经过努力的工作，确保此打印机可以满足您的需求。

如要立刻开始使用您的新打印机，请使用随同打印机一起提供的安装资料，然后快速浏览用户手册了解如何完
成基本任务。如要实现您的打印机的最佳性能，请仔细阅读用户手册，并确认您在我们的网站上检查了最新的
升级。

我们致力于通过我们的打印机提供性能和价值，并且我们希望确保您满意。如果您在使用过程中遇到任何问
题，我们知识渊博的技术支持代表将会很高兴地帮助您迅速恢复正常使用。如果您发现哪些事情我们可以做得
更好，请告诉我们。毕竟我们所做的这一切都是为了您，您的建议可以帮助我们做得更好。

使您的打印机对环境的影响最小
我们致力于保护环境，并且不断地改善我们的打印机以减少它们对环境的影响。通过选择某些打印机设置或任
务，您可以更进一步地减少您的打印机对环境的影响。

节约能源
• 启用经济模式。此功能将屏幕亮度设置为低，并设置打印机在空闲 10 分钟之后进入节约能源模式。

• 选择较低的节约能源时限。打印机空闲一段时间之后，节约能源功能将会让打印机进入最小能耗待机模
式，这段时间称为节约能源时限。

• 共享您的打印机。无线／网络打印机允许您在多台计算机之间共享一台打印机，这样可以节约能源和其他
资源。

节约纸张
• 启用经济模式。在某些打印机型号上，此功能设置打印机自动将打印、复印和传真作业在纸张的双面进行
打印（双面打印）。

• 在纸张的一面上打印多页图像。“合并打印”功能允许您在一张纸上打印多页。您最多可以在一张纸的一
面上打印 8 页图像。

• 在纸张的双面进行打印。双面打印允许您手动或自动在纸张的双面进行打印（取决于您的打印机型号）。

• 在打印之前预览打印作业。您可以在“打印预览”对话框中或打印机的显示屏上使用预览功能（取决于您
的打印机型号）。

• 扫描并保存。为了避免打印多份，您可以扫描文档或照片，然后将它们保存在计算机应用程序或闪存驱动
器中进行演示。

• 使用可回收的纸张。

节约墨水
• 使用“高速”或“草稿”模式。使用这些模式打印文档可以比正常情况使用较少的墨水，最适合于打印文
本为主的文档。

• 使用高容量打印墨盒。高容量打印墨盒中的墨水允许您使用较少的打印墨盒打印较多的页数。

• 清洗打印头。在更换和回收您的打印墨盒之前，请尝试使用“清洗打印头”和“深度清洗打印头”功能。
这些功能可以清洗打印头喷头并提高您的打印结果的质量。

关于您的打印机
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回收
• 回收产品包装。

• 回收您的旧打印机，而不要丢弃。

• 从作废的打印作业中回收纸张。

• 使用可回收的纸张。

查找有关打印机的信息

出版物

您正在找什么？ 可以从这里得到：

初始安装指导：

• 连接打印机

• 安装打印机软件

安装文档

安装文档随同打印机一起提供。

有关使用打印机的更多设置和指导：

• 选择和储存纸张和特殊介质

• 装入纸张

• 完成打印、复印、扫描和传真任务，取决于您
的打印机型号

• 配置打印机设置

• 浏览并打印文档和照片

• 安装和使用打印机软件

• 在网络中安装并配置打印机，取决于您的打印
机型号

• 照料和维护打印机

• 发现和解决问题

用户手册

用户手册可以从安装软件光盘中获得。

如要获取更新，请访问我们的网站 support.dell.com。

有关使用打印机软件的帮助 Windows 帮助

打开打印机软件应用程序，然后单击“帮助”。

单击  可以浏览上下文相关信息。

注意：

• 帮助文件随同打印机软件一起自动安装。

• 打印机软件位于打印机程序文件夹中或者计算机桌面上，
取决于您的操作系统。

关于您的打印机
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您正在找什么？ 可以从这里得到：

最新的补充信息、升级和在线技术支持：

• 问题解答提示

• 常见问答

• 文档

• 驱动程序下载

• 在线聊天技术支持

• 电子邮件技术支持

• 电话技术支持

Dell 技术支持网站 support.dell.com

注意：选择您所在的国家或地区，然后选择您的产品以浏览适
当的技术支持网站。

您所在国家或地区的技术支持电话号码和服务时间可以在技术
支持网站上获得。

当您联系技术支持时，请准备好以下信息，以便我们能够更快
地为您服务：

• 服务序列号

• 服务序列号

注意：服务序列号和服务编号可以在位于您的打印机上的标签
上找到。

• 软件和驱动程序 — 经过认证的打印机驱动程序
和 Dell 打印机软件安装程序

• 自述文件 — 为有经验的用户或技术员提供有关
打印机的最新技术变更信息或高级技术参考资
料

安装软件光盘

注意：如果您同时购买了 Dell 计算机和打印机，打印机文档和
驱动程序已经安装在您的计算机上。

• 您的打印机的耗材和附件

• 替换打印墨盒

Dell 打印机耗材网站 dell.com/supplies

您可以在网站上、通过电话或者在指定的零售商店购买打印机
耗材。

• 准备操作您的打印机的相关安全信息

• 管制信息

• 保修信息

产品信息手册

注意：在您的国家或地区可能不提供产品信息手册。

关于您的打印机
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了解打印机的部件

使用此部件： 您可以：

1 纸张支架 装入纸张。

2 Wi-Fi 指示灯 检查无线状态。

3 存储卡插槽 插入存储卡。

4 PictBridge 和 USB 接口 将 PictBridge 兼容数码相机、USB 蓝牙适配器或闪存驱动器连接在打印机
上。

5 读卡器指示灯 检查读卡器的状态。指示灯闪烁表示正在读取存储卡。

6 出纸托盘 盛放打印机送出的打印页。

7 打印机操作面板 操作打印机。

8 自动文档传送器(ADF)进纸导轨 确保纸张能够垂直进入自动文档传送器内。

注意：调节 ADF 输入托盘上的进纸导轨，使之和文档原件的宽度相同。

9 自动文档传送器(ADF)输出托盘 盛放自动文档传送器送出的文档。

10 自动文档传送器(ADF)输入托盘 将文档原件装入自动文档传送器内。推荐用于扫描、复印或传真多页文
档。

注意：请不要在自动文档传送器内装入明信片、照片、较小的物体或较薄
的介质（例如杂志剪辑）。请将这些物体放置在扫描仪玻璃上。

11 自动文档传送器(ADF) 扫描、复印或传真多页 Letter、Legal 和 A4 尺寸的文档。

12 进纸保护盖 防止物体掉进纸张通道内。

13 进纸导轨 确保纸张能够垂直进入打印机内。

关于您的打印机
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使用此部件： 您可以：

1 顶盖 打开顶盖可以露出扫描仪玻璃。

2 扫描仪玻璃 扫描和复印照片和文档。

3 安全孔 在您的打印机上安装一根防盗电缆。

4 电源插口 使用电源线为打印机提供电源。

5 EXT（电话分机）插口 将其他设备（电话机或电话答录机）连接在打印机和电话线上。如果您的打印机没
有使用专用传真线路，并且您所在的国家／地区支持这种连接方法，请使用此插
口。

注意：取下保护塞可以露出插口。

6 LINE（线路）插口 将打印机连接在可用的电话线上（通过标准墙壁电话线插座、DSL 过滤器或 VoIP
适配器），以便发送和接收传真。

7 USB 接口 使用 USB 电缆将打印机连接在计算机上。

警告—可能的损坏：除了插入或断开 USB 电缆或安装电缆的时候，请不要触摸
USB 接口。

8 打印头 安装、更换或取出打印墨盒。

9 扫描仪部件 • 抬起扫描仪部件可以露出打印墨盒和打印头。

• 清除卡纸。

关于您的打印机
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订购和更换耗材

订购打印墨盒
如要获取可打印页数的数值，请访问网站 www.dell.com/supplies。要获得最佳效果，请只使用 Dell 打印墨
盒。

项目： 授权打印墨盒：1 常规打印墨盒：

黑色打印墨盒 Series 21 Series 21R

黑色打印墨盒，高容量 2 Series 23 Series 23R

彩色打印墨盒 Series 21 Series 21R

彩色打印墨盒，高容量 2 Series 23 Series 23R

1 只允许单次使用。使用后请将此打印墨盒返还给 Dell 进行再制造、再填充或再循环。如要了解更多有关回收 Dell
产品的信息，请访问网站 www.dell.com/recycling。
2 只能从 Dell 网站 www.dell.com/supplies 上获得。

更换打印墨盒
在您开始操作之前，请确认您有新的打印墨盒。

1 打开您的打印机的电源。

2 打开打印机。

注意：打印头将会移动到打印墨盒安装位置。

订购和更换耗材
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3 按释放按钮，然后取出旧的打印墨盒。

警告—可能的损坏：请不要取出旧的打印墨盒，直到您准备好新的打印墨盒，否则打印头中剩余的墨水可
能会干燥并堵塞喷头。

4 打开打印墨盒的包装。

如果您的打印墨盒带有一个套盖，请去掉盖子。

如果您的打印墨盒带有一个旋转盖，请旋转并去掉盖子。

订购和更换耗材
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5 安装每一个打印墨盒。如有必要，请使用两只手。

注意：取下保护盖后请立刻安装新的打印墨盒，以避免墨水暴露在空气中。

6 关闭打印机。

回收 Dell 产品
如要将 Dell 产品返回给 Dell 进行再循环：

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击“打印机主页”。

4 从打印机下拉列表中选择您的打印机。

5 在“维护”选项卡中单击“订购耗材”。

6 单击  图标。

7 按照计算机屏幕上的指导进行操作。

订购和更换耗材
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使用打印机操作面板按钮和菜单

使用打印机操作面板
以下图表详细地介绍了打印机操作面板的各个区域：

按此按钮： 您可以：

1 “电源”按钮 • 打开或关闭打印机的电源。

• 进入节约能源模式。

注意：当打印机打开时，按  按钮将会进入节约能源模

式。按住  按钮 3 秒钟将会关闭打印机。

2 “复印”按钮 进入“复印”菜单并进行复印。

3 “扫描”按钮 进入“扫描”菜单并扫描文档。

4 “传真”按钮 进入“传真”菜单并发送传真。

5 “照片”按钮 进入“照片”菜单并打印照片。

6 显示屏

注意：在节约能源模式下，显示屏将会关闭。

显示：

• 打印机的状态

• 信息

• 菜单

7 箭头按钮 选择显示屏上的菜单项或子菜单项。

使用打印机操作面板按钮和菜单
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按此按钮： 您可以：

8 “选择”按钮 • 选择菜单选项。

• 保存设置。

• 送入或送出纸张。按住此按钮 3 秒钟可以送入纸张或者送
出打印机内的纸张。

9 “返回”按钮 • 返回到上一个界面。

• 从当前菜单退出到上一级菜单。

10 “设置”按钮 进入“设置”菜单并改变打印机设置。

注意：按此按钮后，“复印”、“扫描”、“传真”和“照
片”按钮指示灯都将熄灭。

按此按钮： 您可以：

1 通讯簿 从保存的号码列表中选择传真号码。

2 重拨／暂停 在传真模式下：

• 在传真号码中加入三秒钟的暂停，用来等待接通外线或者接通自动应答系统。只有当您
已经开始输入号码后，才可以加入暂停。

• 显示最后一次拨出的号码。反复按左右箭头按钮可以查看最后五次拨出的号码。

3 拨号音 在发送传真之前使用数字符号键区的按钮手动拨打电话号码。

4 彩色／黑白  转换到彩色模式或黑白模式。

5 “开始”按钮 开始打印、扫描、复印或传真作业，取决于所选的模式。

使用打印机操作面板按钮和菜单
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按此按钮： 您可以：

6 “取消”按钮 • 取消正在进行的打印、复印、扫描或传真作业。

• 从“复印”、“扫描”、“传真”、“照片”或“文件打印”菜单的当前位置退出，并
返回到菜单的最高一级。

• 从“设置”菜单的当前位置退出，并返回到上一个模式菜单的最高一级。

• 清除当前的设置或错误信息，并恢复为默认设置。

7 数字符号键区 在复印模式或照片模式下：输入您希望复印或打印的份数。

在传真模式下：

• 输入传真号码。

• 选择自动应答系统。

• 创建快速拨号列表时选择字母。

• 输入或修改显示屏上的日期和时间。

将临时设置改变为新的默认设置
以下菜单将会在打印机不使用 2 分钟之后或者关闭电源之后恢复为默认设置：

“复印”菜单 • 份数

• 质量

• 较浅／较深

• 调整大小

• 原件尺寸

• 每张纸上打印多页

• 每张纸上复制多个

• 内容类型

“扫描”菜单 • 质量

• 原件尺寸

“传真”菜单（仅限于某些型号） • 较浅／较深

• 质量

“照片”菜单 在打印机不使用 2 分钟之后或者关闭电源之后，以下的“照片”选项不会恢复默
认设置，但是当存储卡或闪存驱动器从打印机内取出后，这些设置将会恢复为出
厂默认设置。

• 照片效果

• 照片尺寸

• 版面

• 质量

如要将临时设置改变为新的默认设置

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“默认值”，然后按  按钮。

使用打印机操作面板按钮和菜单
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3 反复按箭头按钮选择“设置默认值”，然后按  按钮。

显示屏上将会出现“使用当前设置”。

4 再次按  按钮选择“使用当前设置”。

5 反复按  按钮，直到您退出“设置”，或者按其他的模式按钮。

如要禁用设置时限功能

如果您不希望打印机在不使用 2 分钟之后或者关闭电源之后恢复为默认的临时设置，您可以禁用设置时限功
能。

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“设备设置”，然后按  按钮。

3 反复按箭头按钮选择“清除设置时限”，然后按  按钮。

4 反复按箭头按钮选择“从不”，然后按  按钮。

5 反复按  按钮，直到您退出“设置”，或者按其他的模式按钮。

改变节约能源时限
打印机将会在空闲一段时间之后进入节约能源模式，这段时间称为节约能源时限。和默认打印机设置相比，节
约能源功能可以通过降低打印机的能源消耗（一些打印机型号可以达到 28%）使能源效率达到最优化。如要
最多地节约能源，请选择最小的节约能源时限。

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“设备设置”，然后按  按钮。

3 反复按箭头按钮选择“节约能源”，然后按  按钮。

4 反复按箭头按钮选择节约能源时限，然后按  按钮。

5 反复按  按钮，直到您退出“设置”，或者按其他的模式按钮。

使用经济模式节约能源
经济模式功能可以使能源效率最优化并节省资金。

当经济模式启用后，打印机自动转变为以下设置：

• 打印机的显示屏将会变暗。

• 打印机在 10 分钟之后进入节约能源模式。

注意：

• 如果您使用经济模式，经济模式设置将会替换所有您对属于经济模式一部分的个别设置所做的改变。

• 默认情况下，经济模式是启用的。

如要改变经济模式设置：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“设备设置”，然后按  按钮。

使用打印机操作面板按钮和菜单
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3 反复按箭头按钮选择“经济模式”。

4 选择经济模式设置，然后按  按钮。

5 反复按  按钮，直到您退出“设置”，或者按其他的模式按钮。

恢复出厂默认设置
恢复出厂默认设置将会删除您所选择的所有打印机设置。

使用打印机操作面板菜单

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“默认值”，然后按  按钮。

3 反复按箭头按钮选择“设置默认值”，然后按  按钮。

4 反复按箭头按钮选择“使用出厂设置”，然后按  按钮。

5 当提示您设置您的打印机的初始设置时，请使用打印机操作面板上的按钮进行选择。

显示屏上将会出现“初识设置完成”。

使用按钮组合（如果您看不懂当前的语言）

1 关闭打印机的电源。

注意：如果您在“设置”菜单中设置了节约能源时限，请按住  按钮 3 秒钟关闭打印机的电源。

2 同时按住打印机操作面板上的  和  按钮，然后按  按钮打开打印机的电源。

注意：请不要放开  和  按钮，直到显示屏上出现“语言”，表示打印机已经恢复完毕。

3 当提示您设置您的打印机的初始设置时，请使用打印机操作面板上的按钮进行选择。

显示屏上将会出现“初识设置完成”。

使用打印机操作面板按钮和菜单
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使用打印机软件

最小系统需求
打印机软件最多需要 500MB 空余硬盘空间。

支持的操作系统
• Microsoft Windows 7

• Microsoft Windows Vista（SP1）

• Microsoft Windows XP（SP3）

• Microsoft Windows 2000（SP4 或更高版本）

• Macintosh Intel OS X version 10.6.0 或更高版本（英文版）（仅限于网上）*

• Macintosh Intel OS X version 10.5.0 或更高版本（英文版）（仅限于网上）*

• Macintosh Intel OS X version 10.4.4 或更高版本（英文版）（仅限于网上）*

• Macintosh PowerPC OS X version 10.5.0 或更高版本（英文版）（仅限于网上）*

• Macintosh PowerPC OS X version 10.4.0-version 10.4.3（英文版）（仅限于网上）*

• Linux Ubuntu 8.04 LTS 和 8.10（仅限于网上）*

• Linux openSUSE 11.0 和 11.1（仅限于网上）*

• Linux Fedora 10（仅限于网上）*

* 适用于此操作系统的打印机驱动程序只能从网站 support.dell.com 上获得。

注意：升级的打印机固件可以从网站 support.dell.com 上获得。

使用 Windows 打印机软件

在打印机安装过程中安装的软件

当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。您可能也选择了安装一些其他的程序。下
面的表格提供了各种软件程序的概述，以及它们可以帮助您做什么。

如果您在初始安装过程中没有安装这些程序，请重新插入安装软件光盘，运行安装程序，然后在“已安装的软
件”界面中选择“安装其他的软件”。

使用打印机软件
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打印机软件

使用此软件： 您可以：

Dell 打印机主页

（简称为打印机主页）

• 运行应用程序。

• 打开传真解决方案软件。

• 扫描或通过电子邮件发送照片或文档。

• 编辑扫描的文档。

• 将文档扫描成 PDF 格式。

• 调整打印机设置。

• 订购耗材。

• 维护打印墨盒。

• 打印测试页。

• 注册打印机。

• 联系技术支持。

Dell 快速照片管理器

（简称为快速照片管理器）

管理、编辑、传送和打印照片和文档。

AdobeTM Photo Album Starter Edition 浏览、管理和编辑照片。

Dell 工具栏

（简称为工具栏）

在 Windows 中打印、扫描或转换本地文件。

Dell 墨水管理系统 订购墨水。

Dell 传真解决方案软件

（简称为传真解决方案软件）

• 发送传真。

• 接收传真（3 合 1 打印机）。

• 添加、编辑或删除内置电话簿中的联系人。

• 打开 Dell 传真设置应用程序。使用传真设置应用程序可以设置快速拨号
和群组拨号号码、设置铃声和应答选项、以及打印传真历史记录和状态
报告。

Abbyy Sprint OCR 扫描文档并生成您可以在文字处理程序中编辑的文本。

Dell 无线设置应用程序

（简称为无线设置应用程序）

• 在无线网络中安装无线打印机。

• 改变打印机的无线设置。

注意：如果打印机有无线功能，此程序将会随同打印机软件一起自动安装。

Dell 服务中心

（简称为服务中心）

• 解决打印机的问题。

• 使用打印机维护功能。

• 联系技术支持。

注意：

• 此程序随同打印机软件一起自动安装。

• 根据您的打印机型号，可能会提示您从网上安装此程序。

使用打印机软件
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使用此软件： 您可以：

打印首选项 当您打开一个文档，然后单击“文件打印”时，打印首选项对话框将会
出现。您可以在对话框中为打印作业选择选项，例如：

• 选择要打印的份数。

• 进行双面打印。

• 选择纸张类型。

• 添加水印。

• 增强图像。

• 保存设置。

注意：打印首选项随同打印机软件一起自动安装。

注意：根据您购买的打印机的功能，您的打印机可能不提供某些程序，或者不支持程序的某些功能。

使用 Macintosh（英文版）打印机软件

在打印机安装过程中安装的软件

Macintosh 操作系统中自带的软件

使用 您可以

Print 对话框 调整打印设置和预定打印作业的时间。

Printer Services 对话框（不适用于 Mac OS X version 10.5 或更高版
本）

• 打开打印机应用程序。

• 问题解答。

• 订购墨水或耗材。

• 联系 Dell。

• 查看计算机上安装的打印机软件版本。

打印机软件

当您安装打印机软件时，同时也安装了一些应用程序。安装完毕后，这些应用程序保存在 Finder 桌面上的打
印机文件夹中。

1 在 Finder 桌面上双击打印机文件夹。

2 双击您希望使用的应用程序的图标。

使用 您可以

Dell All-In-One Center

（简称为 All-In-One Center）
• 扫描照片和文档。

• 为扫描作业定制设置。

Dell AIO Setup Utility

（简称为 AIO Setup Utility）
• 为传真作业定制设置。

• 创建和编辑联系人列表。

Dell Network Card Reader

（简称为 Network Card Reader）
• 浏览插入网络打印机内的存储设备的内容。

• 通过网络将存储设备中的照片和 PDF 文档传送到计算机上。

使用打印机软件
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使用 您可以

Dell Printer Utility

（简称为 Printer Utility）
• 获取有关安装打印墨盒的帮助。

• 打印测试页。

• 打印校正测试页。

• 清洗打印墨盒喷头。

• 订购墨水或耗材。

• 注册您的打印机。

• 联系用户技术支持。

Dell Wireless Setup Assistant

（简称为 Wireless Setup Assistant）

在无线网络中安装打印机。

注意：您的打印机可能没有某些应用程序，取决于您购买的打印机的功能。

查找并安装可选的软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “支持”选项卡 > 在线支持

4 在网站上选择您的打印机，然后下载驱动程序。

5 安装其他或可选的软件。

Macintosh（英文版）用户

1 在 Finder 桌面上双击打印机文件夹。

2 双击 Printer Utility 图标。

3 在 Web Links 选项卡中单击 Customer Support。

4 在网站上选择您的打印机并下载驱动程序。

5 安装其他或可选的软件。

升级打印机软件（仅限于 Windows）

检查软件升级

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击“打印机主页”。

4 从打印机下拉列表中选择您的打印机。

使用打印机软件
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5 在“支持”选项卡中单击“检查升级”。

6 按照计算机屏幕上的指导进行操作。

启用自动软件升级

1 打开文档，从应用程序中单击“文件打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 在“高级”选项卡中单击“更多的选项”。

4 在“软件升级”区域中选中“允许从互联网上自动升级我的软件”。

5 单击“确定”。

重新安装打印机软件
当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。如果您在安装过程中遇到了问题、您的打
印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没有出现在打印机选项中，请尝试反安装并
重新安装打印机软件。

反安装打印机软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击反安装选项。

4 按照计算机屏幕上的指导反安装软件。

5 反安装完毕后，请重新启动您的计算机。

Macintosh（英文版）用户

1 在 Finder 桌面上双击打印机文件夹。

2 双击 Uninstaller 图标。

3 按照计算机屏幕上的指导进行操作。

安装打印机软件

注意：如果您以前在这台计算机上安装了打印机软件，但是需要重新安装软件，请先反安装当前的软件。

Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

使用打印机软件
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如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

c 按 Enter 键，或者单击“确定”。

3 按照“欢迎”界面中的指导进行操作。

Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 从打印机网站上下载最新的安装程序。

3 运行打印机安装软件，然后按照计算机屏幕上的指导进行操作。

使用互联网

升级的打印机软件可以从网站 support.dell.com 上获得。

使用打印机软件
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装入纸张和文档原件

装入纸张
1 来回弯曲纸张，使它们松散开。

请不要折叠或弄皱纸张。在一个平坦表面上将整摞纸张的边缘对齐。

2 在纸张支架的正中间位置装入纸张。

3 调节进纸导轨，使之紧靠纸张的边缘。

注意：请不要用力将纸张塞入打印机内。纸张应该平整地放置在纸张支架的表面上，并且纸张的边缘应该
紧靠两边的进纸导轨。

4 在打印机操作面板上选择或确认您的纸张设置。

装入纸张和文档原件
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纸张和特殊介质指导

最多可以装入： 请确认：

100 张普通纸 • 进纸导轨紧靠纸张的边缘。

• 如要装入印有页眉的信纸，请确认要打印的一面朝上，然后将信
纸的顶端装入打印机内。

25 张重磅亚光纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

20 张横幅纸 • 在装入横幅纸之前，请从纸张支架内取出所有的纸张。

• 您使用的是喷墨打印机专用的横幅纸。

• 将整摞横幅纸放置在打印机的上面或后面，然后将第一页的页首
装入打印机内。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“A4 横幅”或“Letter 横幅”纸张尺寸。

装入纸张和文档原件
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最多可以装入： 请确认：

10 个信封 • 要打印的一面朝上。

• 进纸导轨紧靠信封的边缘。

• 您选择了“横向”设置打印信封。

注意：如果您在日本境内邮寄，您可以选择纵向打印，贴邮票的
位置位于右下角；或者选择横向打印，贴邮票的位置位于左下
角。如果您要向其他国家邮寄，请选择横向打印，贴邮票的位置
位于左上角。

• 您选择了正确的信封尺寸。如果列表中没有完全符合的信封尺
寸，请选择稍大一点的尺寸，然后设置适当的左边距和右边距，
以确保您要打印的内容能够打印在信封的正确位置上。

25 张标签纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

25 张贺卡专用纸、索引卡、明信片或照片卡 • 要打印的一面朝上。

• 进纸导轨紧靠卡片纸的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

25 张照片／光面纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

10 张热转印纸 • 请按照包装上的指导装入热转印纸。

• 要打印的一面朝上。

• 进纸导轨紧靠热转印纸的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

装入纸张和文档原件
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最多可以装入： 请确认：

50 张透明胶片 • 粗糙的一面朝上。

• 进纸导轨紧靠透明胶片的边缘。

保存纸张默认设置
您可以为您打印的文档和照片设置默认的纸张尺寸、纸张类型和照片打印尺寸。

注意：这些默认设置只应用于您从打印机开始的打印、复印和扫描作业。

1 按打印机操作面板上的  按钮。

2 选择默认设置：

• 如果您希望设置默认纸张尺寸：

a 按  按钮选择“纸张设置”。

b 反复按箭头按钮选择“纸张尺寸”，然后按  按钮。

c 反复按箭头按钮为打印机选择默认纸张尺寸，然后按  按钮。

• 如果您希望设置默认纸张类型：

a 按  按钮选择“纸张设置”。

b 反复按箭头按钮选择“纸张类型”，然后按  按钮。

c 反复按箭头按钮为打印机选择默认纸张类型，然后按  按钮。

• 如果您希望设置默认照片打印尺寸：

a 反复按箭头按钮选择“默认值”，然后按  按钮。

b 按  按钮选择“照片打印尺寸”。

c 反复按箭头按钮为打印机选择默认照片打印尺寸，然后按  按钮。

3 反复按  按钮，直到您退出“设置”，或者按其他的模式按钮。

装入纸张和文档原件
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将文档原件放置在扫描仪玻璃上
1 打开扫描仪顶盖，然后将文档原件正面朝下放置在扫描仪玻璃上。

2 关闭扫描仪顶盖。

将文档原件装入自动文档传送器(ADF)内
您最多可以在自动文档传送器(ADF)内装入 35 页文档原件进行扫描、复印和传真。您可以在 ADF 内装入 A4、
Letter 或 Legal 尺寸的纸张。

1 调节 ADF 输入托盘上的进纸导轨，使之和文档原件的宽度相同。

2 将文档原件正面朝上且顶端在前装入自动文档传送器(ADF)内，直到您听见蜂鸣声。

装入纸张和文档原件
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打印

打印提示
• 根据您的打印作业使用适当的纸张。

• 选择较高的打印质量以获得较好的打印结果。

• 请确认打印墨盒中有足够的墨水。

• 当打印照片或特殊介质时，请随时移开打印机送出的打印页。

• 当打印照片时请选择无边界设置。

打印基本文档

打印文档

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 选择打印质量、打印份数、纸张类型和如何打印页面。

4 单击“确定”关闭打印机软件的所有对话框。

5 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项菜单中选择打印质量、打印份数、纸张类型和如何打印页面。

7 单击 Print。

打印
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逐份打印

当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

注意：

• 只有当您打印多份文档时，逐份打印选项才可用。

• 当您打印照片时，为了避免出现污迹，请随时移开打印机送出的照片，等墨水完全干燥后再进行叠放。

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “份数”区域

4 输入您希望打印的份数，然后选中“逐份打印”。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 在 Copies 区域中输入您希望打印的份数，然后选中 Collated。

7 单击 Print。

倒序打印

默认情况下，打印机首先打印第一页。如果您希望按照相反的顺序打印页面，使文档的第一页位于最上面以便
于阅读，请按照以下的步骤进行操作：

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

打印

33



3 在“打印设置”选项卡的“份数”区域中选择打印顺序：

• 如要先打印最后一页，请选中“先打印最后一页”。

• 如要先打印第一页，请取消选中“先打印最后一页”。

注意：如果您启用了双向打印，则您不能先打印最后一页。如要改变打印顺序，您必须首先禁用双面
打印。

4 单击“确定”关闭打印机软件的所有对话框。

5 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File  Print。

2 从 Printer 弹出菜单中选择打印机。

3 如有必要，请单击提示三角。

4 从打印选项弹出菜单中选择 Paper Handling。

5 从 Paper Handling 或 Page Order 弹出菜单中选择打印顺序：

• 如要先打印最后一页，请选中 Reverse page order 或 Reverse。

• 如要先打印第一页，请取消选中 Reverse page order 或 Reverse。

6 单击 Print。

将多页文档打印到一张纸上

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > “布局”下拉列表 > 选择“每张纸上打印多页”

4 选择您希望在每一张纸上合并打印的文档页数。

5 根据您的需要调整其他设置。

6 单击“确定”关闭打印机软件的所有对话框。

7 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

打印
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6 从打印选项弹出菜单中选择 Layout。

7 从 Pages per Sheet 弹出菜单中选择在每一张纸上合并打印的文档页数。

8 根据您的需要调整其他设置。

9 单击 Print。

从存储卡或闪存驱动器中打印文档（仅限于 Windows）
如要使用“文件打印”功能：

• 打印机必须通过 USB 电缆或者通过网络连接在计算机上。

• 打印机和计算机的电源都必须打开。

• 存储卡或闪存驱动器中必须包含打印机支持的文档文件。请参阅第39 页“支持的存储卡和文件类型”获
取更多的信息。

• 计算机上必须安装了可以支持存储设备中的文件类型的应用程序。

1 插入存储卡或闪存驱动器。

当打印机检测到存储设备时，打印机操作面板显示屏上将会出现信息“检测到存储卡”或“检测到存储设
备”。

2 如果存储设备中只包含文档文件，打印机将会自动转换到“文件打印”模式。

如果存储设备中同时包含文档文件和图像文件，请按  按钮选择“文档”。

3 选择并打印文档：

如果打印机使用 USB 连接

a 反复按箭头按钮选择您希望打印的文档的文件名，或者选择文档所在的文件夹。

b 按  按钮，然后按  按钮开始打印文档。

如果打印机使用无线连接（仅限于某些型号）

a 反复按箭头按钮选择您希望打印的文档的文件名。

b 按  按钮，然后等待打印机连接到网络计算机或者搜索网络中可用的计算机。

c 当出现提示时，请反复按箭头按钮选择网络计算机的名称，然后按  按钮开始打印文档。

注意：

• 如果计算机要求识别码，打印机可能会提示您输入识别码。请使用数字符号键区的按钮输入识别
码。

• 如要为计算机指定计算机名和识别码，请参阅适用于您的操作系统的打印机软件帮助。

打印
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打印特殊文档

打印信封

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张类型”下拉列表 > 选择“普通纸”

4 依次选择：

“纸张尺寸”下拉列表 > 选择您的信封尺寸

如果没有完全符合的信封尺寸，请选择自定义尺寸。

5 选择打印方向。

6 单击“确定”关闭打印机软件的所有对话框。

7 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的信封尺寸。

如果没有完全符合的信封尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 单击 Print。

注意：

• 多数信封使用横向打印。

• 请确认您在应用程序中选择了相同的打印方向。

打印标签

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

打印
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3 依次选择：

“打印设置”选项卡 > “纸张类型”下拉列表 > 选择您的纸张类型

4 依次选择：

“纸张尺寸”下拉列表 > 选择您的纸张尺寸

如果没有完全符合的纸张尺寸，请选择自定义尺寸。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的纸张尺寸。

如果没有完全符合的纸张尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从打印选项弹出菜单中选择 Print Settings 或 Quality & Media。

8 从 Paper Type 弹出菜单中选择 Card Stock。

9 从 Print Quality 弹出菜单中选择除 Quick Print 或 Draft 以外的其他打印质量。

10 单击 Print。

有关装入标签纸的提示

• 请确认标签纸的顶部首先装入打印机内。

• 请确认标签纸上的粘性部分距离纸张的边缘至少 1 毫米。

• 请确认进纸导轨紧靠标签纸的边缘。

• 请使用完整的标签纸。如果标签纸不完整（缺少部分标签），其他的标签可能会在打印过程中脱落，从而
导致卡纸。

打印自定义尺寸的纸张

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张尺寸”下拉列表 > 选择“自定义尺寸”

4 根据需要调整设置并创建自定义尺寸，然后单击“确定”。

打印
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5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择 Manage Custom Sizes。

4 根据需要调整设置并创建自定义尺寸，然后单击 OK。

5 从 Paper Size 弹出菜单中选择您创建的自定义尺寸，然后单击 OK。

6 从菜单栏中单击 File > Print。

7 从 Printer 弹出菜单中选择您的打印机。

8 单击 Print。

操作照片

在打印机上使用存储卡或闪存驱动器

存储卡和闪存驱动器是数码相机和计算机经常使用的存储设备。您可以从数码相机中取出存储卡，或者从计算
机上取下闪存驱动器，然后直接插入到打印机上。

1 将存储卡插入存储卡插槽中或者将闪存驱动器插入 USB 接口中。

插入存储卡 插入闪存驱动器

注意：

• 插入存储卡时请确认带有标签的一面朝右。

• 如果存储卡上带有箭头标记，请确认箭头指向打印
机。

• 如果需要，请将存储卡插入随同存储卡一起提供的
适配器中，然后将适配器插入插槽中。

• 请确认打印机支持您插入的存储卡。请参阅第39
页“支持的存储卡和文件类型”获取更多的信息。

注意：

• 闪存驱动器和 PictBridge 数码相机电缆使用同一个
接口。

• 如果您的闪存驱动器无法直接插入接口中，则需要
使用一个适配器。
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警告—可能的损坏：当正在打印、读取或写入存储设备时，请不要触摸任何
电缆、任何网络适配器、任何接口、存储设备或图中所示的打印机区域，否
则可能会发生数据丢失。

2 在显示屏上查找“检测到存储卡”或“检测到存储设备”信息。

注意：

• 如果打印机没有识别出存储设备，请取出并重新插入存储设备。

• 如果存储卡插槽中插入了存储卡，并且您同时将闪存驱动器或设置为大容量存储器模式的数码相机插入
USB 接口中，显示屏上将会出现一条信息，提示您选择您希望使用哪一个存储设备。

支持的存储卡和文件类型

存储卡： 文件类型：

• Secure Digital (SD)

• Secure Digital High Capacity (SDHC)

• Micro Secure Digital (Micro SD)（需要适配器）

• Mini Secure Digital (Mini SD)（需要适配器）

• MultiMedia Card (MMC)

• Reduced Size MultiMedia Card (RS-MMC)（需要适
配器）

• MultiMedia Card mobile (MMCmobile)（需要适配
器）

• Memory Stick

• Memory Stick PRO

• Memory Stick Duo（需要适配器）

• Memory Stick PRO Duo（需要适配器）

• xD-Picture Card

• xD-Picture Card (Type H)

• xD-Picture Card (Type M)

文档：

• .doc (Microsoft Word)

• .xls (Microsoft Excel)

• .ppt (Microsoft PowerPoint)

• .pdf (Adobe Portable Document Format)

• .rtf (Rich Text Format)

• .docx (Microsoft Word Open Document Format)

• .xlsx (Microsoft Excel Open Document Format)

• .pptx (Microsoft PowerPoint Open Document
Format)

• .wpd (WordPerfect)

图像：

• JPEG

• TIFF

使用打印机操作面板打印照片

1 装入照片纸。

2 按打印机操作面板上的  按钮。
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3 插入存储卡、闪存驱动器或设置为大容量存储器模式的数码相机。

如果存储设备中同时包含文档文件和图像文件，请反复按箭头按钮选择“照片”，然后按  按钮。

4 反复按箭头按钮选择“简捷照片”或“打印照片”，然后按  按钮。

注意：

• 如果您希望快速打印照片，请选择“简捷照片”。

• 如果您希望在打印照片之前进行定制，请选择“打印照片”。

5 反复按箭头按钮选择打印照片选项，然后按  按钮。

注意：您可以选择打印最近的照片、打印所有的照片、打印指定日期范围内的照片、通过选择样张页上的
照片编号打印照片、或者使用数码打印序列格式(DPOF)从数码相机中打印预先选择的照片。只有当您的
存储设备中包含有效的 DPOF 文件时，DPOF 选项才会出现。

6 调整打印设置：

• 如果您位于“简捷照片”菜单中，请使用箭头按钮选择纸张尺寸和照片尺寸。选择完每一项之后请按

 按钮。

• 如果您位于“打印照片”菜单中，请使用箭头按钮选择照片尺寸、纸张尺寸、纸张类型、版面、照片效

果和照片的质量，并调整照片的深浅和彩色效果。选择完每一项之后请按  按钮。

7 按“彩色／黑白”按钮设置彩色或黑白打印。

当您选择彩色或黑白打印时，距离您的选择最近的指示灯将会变亮。

8 按  按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

使用打印机软件打印存储设备中的照片

1 装入照片纸，并确认光面或可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指
导。）

2 按打印机操作面板上的  按钮。

3 插入存储卡、闪存驱动器或设置为大容量存储器模式的数码相机。

如果存储设备中同时包含文档文件和图像文件，请按  按钮选择“照片”。

4 传送或打印照片：

如果打印机使用 USB 连接

• 当您插入存储设备时，快速照片管理器将会自动打开。请按照计算机屏幕上的指导将照片传送到计算机
上或者打印照片。

如果打印机使用无线连接（仅限于某些型号）

a 反复按箭头按钮选择“选择计算机”，然后按  按钮。

b 反复按箭头按钮选择您希望保存照片的网络计算机，然后按  按钮。

c 传送或打印照片：

• 当您插入存储设备时，快速照片管理器将会自动打开。请按照计算机屏幕上的指导将照片传送到计
算机上或者打印照片。
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从 PictBridge 兼容数码相机中打印照片

大部分数码相机都支持 PictBridge 技术，可以允许您直接从您的数码相机中打印照片，无需连接计算机。

1 将 USB 电缆的一端连接在数码相机上。

注意：请只使用随同数码相机一起提供的 USB 电缆。

2 将 USB 电缆的另一端插入打印机前面的 PictBridge 接口中。

注意：

• 请确认 PictBridge 兼容数码相机被设置为正确的 USB 模式。如果不正确，数码相机可能会被检测为一
个闪存驱动器，或者打印机操作面板显示屏上可能会出现错误信息。请参阅数码相机说明文档获取更
多的信息。

• 打印机每次只能读取一种存储设备。

警告—可能的损坏：当正在从 PictBridge 兼容数码相机中打印时，请不要触
摸 USB 电缆、任何网络适配器、任何接口或图中所示的打印机区域，否则
可能会发生数据丢失。

3 如果 PictBridge 连接成功，打印机显示屏上将会出现信息“检测到 PictBridge数码相机。按‘确

定’按钮改变设置。”。

4 按  按钮进入“PictBridge”菜单。
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5 反复按箭头按钮选择您希望打印的照片的纸张尺寸、纸张类型、照片尺寸和版面。选择完每一项之后请按

 按钮。

6 请参阅数码相机说明文档开始打印。

注意：当打印机正在打印其他作业时，如果您连接了数码相机，请等待作业完成，然后再从数码相机中进行打
印。

使用样张页打印存储设备中的照片

1 装入 A4 或 Letter 尺寸的普通纸。

2 按打印机操作面板上的  按钮。

3 插入存储卡或闪存驱动器。

如果存储设备中同时包含文档文件和图像文件，请反复按箭头按钮选择“照片”，然后按  按钮。

4 反复按箭头按钮选择“样张页”，然后按  按钮。

5 反复按箭头按钮选择打印样张页的选项。

您可以选择以下选项打印样张页：

• 为存储设备中所有的照片。

• 为最近的 20 张照片（如果存储设备中的照片多于 20 张）。

• 按照日期范围（如果存储设备中的照片是在不同的日期拍摄的）。如果您选择了此选项，请选择日期。

6 按  按钮。

样张页将会打印出来。

7 按照样张页上的指导选择要打印的照片、每张照片的份数、去除红眼、版面、打印选项和纸张尺寸。

注意：当您进行选择时，请确认完全填满圆圈。

8 当显示屏上出现“扫描样张页”时，请按  按钮，然后将样张页正面朝下放置在扫描仪玻璃上。

注意：如果“扫描样张页”没有出现在显示屏上，请反复按箭头按钮，直到显示出此选项。

9 按  按钮。

打印机开始扫描样张页。

10 装入照片纸，并确认光面或可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指
导。）

注意：请确认纸张尺寸与您在样张页中选择的纸张尺寸一致。

11 按“彩色／黑白”按钮设置彩色或黑白打印。

当您选择彩色或黑白打印时，距离您的选择最近的指示灯将会变亮。

12 按  按钮开始打印照片。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。
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使用 DPOF 从数码相机中打印照片

如果您的数码相机支持数码打印序列格式(DPOF)功能，并且存储卡仍然留在数码相机中，则您可以指定打印
哪些照片、每张照片打印几张和其他打印设置。当您将存储卡插入打印机内或者将数码相机连接在打印机上以
后，打印机可以识别这些设置。

注意：当存储卡仍然留在数码相机中的时候，如果您指定了照片尺寸，请确认您装入打印机内的纸张尺寸不小
于您在 DPOF 选择中指定的尺寸。

1 装入照片纸，并确认光面或可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指
导。）

2 按打印机操作面板上的  按钮。

3 插入存储卡。

显示屏上将会出现信息“检测到存储卡”。

4 反复按箭头按钮选择“打印照片”，然后按  按钮。

5 反复按箭头按钮选择“打印 DPOF”，然后按  按钮打印照片。

注意：只有在存储卡中检测到 DPOF 文件时，此选项才会出现。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

从蓝牙设备中进行打印
• 此打印机可以兼容蓝牙规范 2.0。它支持以下的工作模式：对象推送模式(OPP)和串口模式(SPP)。请咨询
您的蓝牙设备制造商（手机或 PDA），以确定他们的硬件兼容性和互用性。建议在您的蓝牙设备上使用最
新的固件。

• 如要从您的 Windows Mobile／Pocket PC PDA 中打印 Microsoft 文档，您需要额外的第三方的软件和驱动
程序。如要获取有关所需软件和驱动程序的更多信息，请参阅您的 PDA 的帮助文档。

设置您的打印机和蓝牙设备之间的连接

注意：打印机不支持使用蓝牙连接从您的计算机打印文件。

当您第一次从蓝牙设备发送打印作业时，您需要设置蓝牙设备和您的打印机之间的连接。如果出现以下情况，
您需要重新设置：

• 您将打印机恢复为出厂默认设置。

• 您改变了蓝牙安全等级或蓝牙密码。

• 您使用的蓝牙设备需要用户每次打印作业都设置蓝牙连接。请参阅您的蓝牙设备的说明文档获取更多的信
息。

• 您使用的蓝牙设备名称被自动从蓝牙设备列表中删除了。

当蓝牙安全等级设置为“高”时，打印机将会保存一个已经设置了与打印机的连接的蓝牙设备列表（最多
8 个设备）。当打印机检测到多于 8 个设备时，最长时间没有使用的设备将被从列表中删除。您需要重新
设置删除的设备，然后才可以向打印机发送打印作业。

注意：您需要为每一个要向打印机发送打印作业的蓝牙设备设置连接。
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如要设置打印机和蓝牙设备之间的连接：

1 将 USB 蓝牙适配器插入打印机前面的 USB 接口中。

显示屏上将会出现信息“蓝牙 Dongle已连接”。

注意：打印机包装箱内不包含蓝牙适配器。

2 按打印机操作面板上的  按钮。

3 反复按箭头按钮选择“蓝牙设置”，然后按  按钮。

4 反复按箭头按钮选择“发现”，然后按  按钮。

5 请确认“发现”菜单项被设置为“开”。如有必要，请反复按箭头按钮选择“开”，然后按  按钮。

打印机已经准备就绪，可以接收来自蓝牙设备的连接。

6 配置蓝牙设备，设置与打印机的连接。请参阅您的蓝牙设备的说明文档获取更多的信息。

注意：如果打印机上的“蓝牙安全等级”被设置为“高”，您必须输入一个密码。
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设置蓝牙安全等级

1 将 USB 蓝牙适配器插入打印机前面的 USB 接口中。

显示屏上将会出现信息“蓝牙 Dongle已连接”。

注意：打印机包装箱内不包含蓝牙适配器。

2 按打印机操作面板上的  按钮。

3 反复按箭头按钮选择“蓝牙设置”，然后按  按钮。

4 反复按箭头按钮选择“安全等级”，然后按  按钮。

5 反复按箭头按钮选择您希望的安全等级，然后按  按钮。

• 选择“低”可以允许蓝牙设备连接到您的打印机并发送打印作业，不需要用户输入密码。

• 选择“高”需要用户在蓝牙设备上输入一个 4 位数字的密码，然后才可以连接到打印机并发送打印作
业。

6 如果您设置的安全等级为“高”，“蓝牙密码”菜单将会出现在操作面板显示屏上。使用数字符号键区的

按钮输入您的 4 位数字密码，然后按  按钮。

从蓝牙设备中打印

注意：打印机不支持使用蓝牙连接从您的计算机打印文件。
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1 将 USB 蓝牙适配器插入打印机前面的 USB 接口中。

显示屏上将会出现信息“蓝牙 Dongle已连接”。

警告—可能的损坏：当正在打印、读取或写入蓝牙设备时，请不要触摸电缆、任何网络适配器、任何接
口、USB 蓝牙适配器或图中所示的打印机区域，否则可能会发生数据丢失。

注意：

• 打印机包装箱内不包含蓝牙适配器。

• 当您插入 USB 蓝牙适配器后，您的打印机自动进入蓝牙模式。

2 请确认打印机已完成设置，可以接收蓝牙连接。请参阅第 43 页“设置您的打印机和蓝牙设备之间的连
接”获取更多的信息。

3 设置蓝牙设备打印到打印机。请参阅您的蓝牙设备的帮助文档获取更多的信息。

4 请参阅您的蓝牙设备的帮助文档开始打印。

注意：如果打印机上的蓝牙安全等级设置为“高”，您必须输入一个密码。

在纸张的双面进行打印

手动在纸张的双面进行打印

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“手动”

注意：“打印指导页可以帮助您重新装纸”自动被选中。
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4 单击“确定”。打印机首先打印文档的奇数页，然后打印一张指导页。

5 按照指导页中的指导翻转并重新装入打印页。打印机在纸张的背面打印文档的偶数页，完成打印作业。

如要恢复单面打印，请依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“关”

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Paper Handling。

7 从 Print 或 Pages to Print 弹出菜单中选择打印奇数页。

8 单击 Print。

9 翻转并重新装入纸张。

10 重复步骤 4-6。

11 从 Print 或 Pages to Print 弹出菜单中选择打印偶数页。

12 单击 Print。
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管理打印作业

将您的打印机设置为默认打印机

当您发送打印作业时，您的打印机应该在“打印”对话框中自动被选中。如果您必须手动选择您的打印机，说
明您的打印机不是默认打印机。

如要设置默认打印机：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后单击“设为默认打印机”。

Macintosh（英文版）用户

1 从 Apple 菜单中单击 System Preferences。

2 单击 Print & Fax。

3 从 Default Printer 弹出菜单中选择打印机，或者选择打印机，然后单击 Make Default，取决于您的操作系
统。

改变打印模式

如要节省墨水，您可以为所有打印作业将默认打印模式改变为“草稿”或“高速”。此模式可以使用较少的墨
水，最适合于打印文本文档。如果您需要打印照片或其他高质量的文档，您可以在发送打印作业之前在“打
印”对话框中选择不同的模式。

如要改变默认打印模式：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后单击“打印首选项”。

5 选择“高速”作为打印模式。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择打印机。
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3 从打印选项弹出菜单中选择 Print Settings 或 Quality & Media，取决于您的操作系统。

4 从 Print Quality 弹出菜单中选择 Draft 或 Quick Print 作为打印模式。

5 从 Presets 弹出菜单中选择 Save as，然后为您的设置配置输入一个名称。

每次发送打印作业时，您都必须从 Presets 弹出菜单中选择此配置名称。

为单个打印作业改变打印模式

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 选择“自动”、“高速”、“正常”或“最佳”。

注意：使用“草稿”或“高速”模式打印可以使用较少的墨水，最适合于打印文本文档。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择打印机。

3 从打印选项弹出菜单中选择 Print Settings 或 Quality & Media，取决于您的操作系统。

4 从 Print Quality 弹出菜单中选择 Automatic、Draft 或 Quick Print、Normal、Photo 或 Best。

注意：使用 Quick Print 模式打印可以使用较少的墨水，最适合于打印文本文档。

暂停打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 暂停打印作业：

• 如果您希望暂停特定的打印作业，请右键单击文档名，然后单击“暂停”。

• 如果您希望暂停队列中所有的打印作业，请单击“打印机”菜单，然后选中“暂停打印”。

Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 暂停打印作业：

• 如果您希望暂停特定的打印作业，请选择文档名，然后单击 Hold。

• 如果您希望暂停队列中所有的打印作业，请单击 Pause Printer 或 Stop Jobs，取决于您的操作系统。
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继续打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 继续打印作业：

• 如果您希望继续特定的打印作业，请右键单击文档名，然后单击“继续”或“重新启动”。

• 如果您希望继续队列中所有的打印作业，请单击“打印机”菜单，然后取消选中“暂停打印”。

Macintosh（英文版）用户

1 从 Apple 菜单中单击 System Preferences。

2 单击 Print & Fax。

3 从 Printers 列表或弹出菜单中选择打印机。

4 单击 Open Print Queue 或 Set Up Printers，取决于您的操作系统。

打印队列对话框将会出现。

5 继续打印作业：

• 如果您希望继续特定的打印作业，请选择文档名称，然后单击 Resume。

• 如果您希望继续队列中所有的打印作业，请单击 Resume Printer 或 Start Jobs。

取消打印作业

如要取消从打印机操作面板开始的打印作业，请按  按钮。如要取消从计算机开始的打印作业，请根据您的
操作系统选择操作：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 取消打印作业：

• 如果您希望取消特定的打印作业，请右键单击文档名，然后单击“取消”。

• 如果您希望取消队列中所有的打印作业，请单击“打印机  > 取消所有文档”。
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Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

2 在打印队列对话框中选择您希望取消的作业，然后单击 Delete。
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复印

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页的文档。

注意：ADF 只在某些型号上才有。如果您购买的打印机
没有 ADF，请将文档原件或照片放置在扫描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

复印提示
• 当使用自动文档传送器(ADF)时，请调节 ADF 输入托盘上的进纸导轨，使之和文档原件的宽度相同。

• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描结果中出现黑边。

• 请不要在自动文档传送器内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志
剪辑）。请将这些物体放置在扫描仪玻璃上。

进行复印
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按箭头按钮选择复印份数，然后按“彩色／黑白”按钮选择彩色或黑白复印。

当您选择彩色或黑白打印时，距离您的选择最近的指示灯将会变亮。

5 按  按钮。

复印照片
1 装入照片纸。

2 将照片正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按  按钮，直到显示出“照片重印”。
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5 反复按箭头按钮选择“是”，然后按  按钮。

6 反复按箭头按钮选择您希望的照片尺寸，然后按  按钮。

7 按  按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

放大或缩小图像
1 装入纸张。

2 将文档原件正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按  按钮，直到显示出“调整大小”。

5 反复按箭头按钮选择您希望的设置。

注意：

• 如果您选择了“自定义%”，请按  按钮，然后反复按箭头按钮选择您希望的自定义百分比数值。

按  按钮保存设置。

• 如果您选择了“无边界”，打印机将会根据需要自动缩小或放大文档或照片，在您所选择的纸张尺寸
上进行无边界打印。当您选择此设置时，如要获得最佳效果，请使用照片纸，并且设置纸张类型
为“照片”或者让打印机自动检测纸张类型。

6 按  按钮。

注意：当复印作业完成后，请按  按钮将设置恢复为默认值。当打印机不使用 2 分钟之后，“调整大小”设
置也会恢复为 100%。

调整复印质量
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按  按钮，直到显示出“质量”。

5 反复按箭头按钮设置复印质量为“自动”、“高速”、“正常”或“照片”。

6 按  按钮。

使复印结果较浅或者较深
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按  按钮，直到显示出“较浅／较深”。
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5 反复按箭头按钮调整滑动条。

注意：按左箭头按钮可以使复印结果较浅，按右箭头按钮可以使复印结果较深。

6 按  按钮。

使用打印机操作面板进行逐份复印
如果您要将一份多页的文档打印多份，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不
逐份）。

逐份 不逐份

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按箭头按钮选择复印份数，然后按  按钮。

5 反复按  按钮，直到显示出“逐份打印”。

6 反复按箭头按钮选择“开”。

7 按  按钮。

在一页纸上复制图像
您可以将同样一个图像在一页纸上打印多个。此功能可以帮助您制作标签、贴纸、广告和宣传单。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按  按钮，直到显示出“每张纸上复制多个”。

5 反复按箭头按钮选择您希望在一页纸上复制的图像数目：1 个、4 个、9 个或 16 个。

6 按  按钮。

将多页文档复印到一张纸上
通过将每一页文档打印成较小的图像，“每张纸上打印多页”功能可以允许您将多页文档复印到一张纸上。例
如，如果您使用此功能在一张纸上打印 4 页文档，则您可以将一份 20 页的文档减少为 5 页。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。
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4 反复按  按钮，直到显示出“每张纸上打印多页”。

5 反复按箭头按钮选择您希望在一张纸上复印的文档页数。您可以选择在一张纸上复印 1 页、2 页或 4 页文
档。

注意：如果您要按照横向格式复印 4 页文档，请先扫描第 3 页和第 4 页，然后再扫描第 1 页和第 2 页。

6 按  按钮。

手动进行双面复印
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 按打印机操作面板上的  按钮。

4 反复按箭头按钮选择复印份数，然后按“彩色／黑白”按钮选择彩色或黑白复印。

当您选择彩色或黑白打印时，距离您的选择最近的指示灯将会变亮。

5 按  在纸张的一面进行打印。

6 装入文档的下一页。

• 如果您要复印单面文档，请将下一页正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描
仪玻璃上。

• 如果您要复印双面文档，请翻转文档原件，然后将它正面朝上装入自动文档传送器(ADF)内，或者正面
朝下放置在扫描仪玻璃上。

7 从出纸托盘中取出纸张，然后重新装入纸张打印文档的另外一面。

8 按  按钮。

取消复印作业
如要取消复印作业，请按  按钮。

扫描将会停止，并且打印机返回到之前的菜单。
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扫描

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页的文档。

注意：ADF 只在某些型号上才有。如果您购买的打印机
没有 ADF，请将文档原件或照片放置在扫描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。

扫描提示
• 当使用自动文档传送器(ADF)时，请调节 ADF 输入托盘上的进纸导轨，使之和文档原件的宽度相同。

• 当使用扫描仪玻璃时，请关闭顶盖，以避免扫描结果中出现黑边。

• 请不要在自动文档传送器内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志
剪辑）。请将这些物体放置在扫描仪玻璃上。

• 如果您希望扫描多页并将它们保存为一个文件，请选择 PDF 文件类型。

扫描到本地或网络计算机
1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 按打印机操作面板上的  按钮。

3 反复按箭头按钮选择“计算机”或“网络”，然后按  按钮。

4 反复按箭头按钮选择本地或网络计算机的名称，然后按  按钮。

本地或网络计算机是用于接收扫描结果的目的地。等待打印机下载所选计算机上可用的扫描应用程序列表。

注意：

• 如果打印机只连接在本地计算机上，打印机将会自动下载扫描应用程序列表。

• 如果计算机要求识别码，打印机可能会提示您输入识别码。请使用数字符号键区的按钮输入识别码。

• 如要为计算机指定计算机名和识别码，请参阅适用于您的操作系统的打印机软件帮助。

5 反复按箭头按钮选择一个应用程序，然后按  按钮。

6 反复按箭头按钮选择分辨率质量和图像原件尺寸。选择完每一项之后请按  按钮。

7 按  按钮开始扫描。
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扫描完毕后，您在步骤 5 中选择的应用程序将会在目的地计算机上打开，并且扫描结果在应用程序中显示为
一个新的文件。

扫描至闪存驱动器或存储卡
在您开始操作之前，请确认您的闪存驱动器或存储卡没有设置写入保护。

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 按打印机操作面板上的  按钮。

3 当显示屏上出现“扫描至”时，请插入闪存驱动器或存储卡。

4 反复按箭头按钮选择“USB闪存驱动器”或“存储卡”，然后按  按钮。

5 反复按箭头按钮选择分辨率质量、您希望创建的输出类型和图像原件尺寸。选择完每一项之后请按  按
钮。

注意：如果您希望扫描多页并将它们保存为一个文件，请选择 PDF 文件类型。

6 按  按钮开始扫描。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。

扫描照片并发送到编辑应用程序中

Windows 用户

1 装入照片。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 照片

• 如果您希望扫描单张照片，或者将多张照片扫描成一个图像，请选择“单张照片”。

• 如果您希望一次扫描多张照片，并且分别保存为单独的图像，请选择“分成单独的照片”。

注意：在这种情况下，请确保照片之间有至少 1/4 英寸的距离。

扫描开始，并且扫描进度对话框将会出现。

5 保存照片，然后在照片编辑应用程序中打开照片并进行编辑。

Macintosh（英文版）用户

1 装入照片。

2 在 Finder 桌面上双击打印机文件夹。

3 双击打印机 Center 打开 All-In-One Center。

4 从 All-In-One Center 的 What is being scanned?区域中选择 Photo。

5 从 How will the scanned image be used?弹出菜单中选择 To be printed 或 To be viewed on monitor/Web
page。
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6 从 Send scanned image to 弹出菜单中为扫描的图像选择目的地文件夹或应用程序。

7 如果您要扫描多张照片，请选择 Prompt for multiple pages。

8 单击 Preview/Edit。

Scan 对话框将会出现。

9 根据您的需要调整图像和扫描设置。

10 单击 Scan。

扫描文档并发送到编辑应用程序中
光学字符识别(OCR)应用程序可以允许您编辑扫描的文本文档。如要使用此功能，您必须在本地或网络计算机
上安装 OCR 应用程序，并且当您设置扫描作业时必须从应用程序列表中选择它。

当您为扫描作业选择设置时：

• 请选择扫描到安装了 OCR 应用程序的本地或网络计算机。

• 请选择使用最高的分辨率进行扫描。

Windows 用户

1 装入文档原件。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 文档

扫描开始，并且扫描进度对话框将会出现。

5 扫描完毕后，在文字处理应用程序中保存文档。

6 在所选的应用程序中打开文档并进行编辑。

Macintosh（英文版）用户

1 装入文档原件。

2 在 Finder 桌面上双击打印机文件夹。

3 双击打印机 Center 打开 All-In-One Center。

4 从 All-In-One Center 的 What is being scanned?区域中选择除 Photo 以外的其他文档类型。

5 从 How will the scanned image be used?弹出菜单中选择 To be edited (OCR)。

6 从 Send scanned image to 弹出菜单中选择用于进行编辑的文字处理应用程序。

7 单击 Scan。

8 在文字处理应用程序中打开扫描的文档并进行编辑。
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使用打印机软件直接扫描至电子邮件

Windows 用户

1 装入文档原件。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 电子邮件

5 选择“照片”、“文档”或“PDF”。

注意：只有当您的计算机上安装了 OCR 应用程序时，您才可以选择“文档”。

扫描开始，并且扫描进度对话框将会出现。

6 扫描完毕后将会创建一封新的电子邮件，并且自动附加扫描的文档。

7 在您的电子邮件中输入正文。

注意：如果您的电子邮件应用程序没有自动打开，您可以将文档扫描至计算机，然后作为附件通过电子邮件发
送出去。

Macintosh（英文版）用户

1 装入文档原件。

2 在 Finder 桌面上双击打印机文件夹。

3 双击打印机 Center 打开 All-In-One Center。

4 从 All-In-One Center 的 What is being scanned?区域中选择文档类型。

5 从 How will the scanned image be used?弹出菜单中选择 To be viewed on monitor/Web page。

6 从 Send scanned image to 弹出菜单中选择应用程序。

7 单击 Scan。

8 在应用程序中打开扫描的图像，然后作为附件通过电子邮件发送出去。

扫描至 PDF

Windows 用户

1 装入文档原件。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。
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4 依次选择：

打印机主页 > 选择您的打印机 > PDF

扫描开始，并且扫描进度对话框将会出现。

5 将文档保存为 PDF 文件。

Macintosh（英文版）用户

1 装入文档原件。

2 在 Finder 桌面上双击打印机文件夹。

3 双击打印机 Center 打开 All-In-One Center。

4 从 All-In-One Center 的 What is being scanned?区域中选择文档类型。

5 根据您的需要定制设置。

6 单击 Scan。

7 将文档保存为 PDF 文件。

扫描常见问答

我如何提高扫描质量？
• 请确认您的文档原件完好无误。

• 请确认用于接收扫描结果的应用程序是适当的应用程序。例如，如果您要扫描照片并进行编辑，请确认您
选择了照片编辑应用程序接收扫描结果。如果您要扫描文档并编辑其中的文本，请确认您选择了 OCR 应
用程序。

• 使用较高的分辨率。

我如何进行黑白扫描？

所有的扫描作业默认都是彩色的。如要进行黑白扫描，请按打印机操作面板上的“彩色／黑白”按钮从彩色扫
描转换为黑白扫描。

为什么会要求我输入识别码？

识别码是一种安全措施，用于限制扫描的信息只发送到指定的位置，或者防止其他人看到或使用扫描的内容。
如果您要发送扫描结果的网络计算机需要识别码，打印机可能会提示您输入识别码。

如要了解如何为网络计算机指定识别码，请参阅适用于您的操作系统的打印机软件帮助。

什么是应用程序列表？我如何更新列表？

当您扫描文档时，您可以选择在您的计算机上使用哪一个应用程序打开它。当第一次扫描时，打印机将会从您
的计算机上下载应用程序列表。如果您在列表中没有看到您希望的应用程序，或者您在您的计算机上安装了新
的应用程序，请在打印机上更新应用程序列表。
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更新应用程序列表

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“计算机”或“网络”。

3 选择用于接收扫描结果的本地或网络计算机，然后按  按钮。

等待打印机下载所选计算机上可用的扫描应用程序列表。

4 从扫描应用程序列表中选择“刷新”。

此操作将会更新打印机内的应用程序列表。

取消扫描作业
按打印机操作面板上的  按钮，或者在计算机屏幕上单击“取消”。
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传真
当心—电击危险：请不要在雷雨天气时使用传真功能。请不要在雷雨天气时安装此产品，或者进行任何电
线／电缆连接（例如电源线，电话线等）。

设置打印机进行传真

方法 1：标准电话线

查看以下的安装方法，然后按照适用于您的电话线的方法进行安装。

安装方法 1：打印机连接在专用传真线上

此安装方法的提示：

• 您可以设置打印机自动接收传真（自动应答开）或手动接收传真（自动应答关）。

• 如果您希望自动接收传真（自动应答开），您可以设置打印机在您希望的任意数目的铃响之后应答来电。
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安装方法 2：打印机和电话答录机共用电话线

连接在同一个墙壁电话线插座上

连接在不同的墙壁电话线插座上

此安装方法的提示：

• 如果您的电话线上只有一个电话号码，或者您没有申请特色铃声服务，您需要设置打印机自动接收传真
（自动应答开）。

• 请设置打印机比电话答录机多 2 声铃响应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设
置打印机在 6 声铃响之后应答来电。在这种情况下，电话答录机首先应答来电并接收您的语音来电。如果
来电是传真，打印机可以检测到线路上的传真信号并接管来电。

• 如果您申请了您的电话公司提供的特色铃声服务，请确认您为打印机设置了正确的特色铃声模式。否则，
即使您设置了打印机自动接收传真，打印机也不会接收传真。
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安装方法 3：打印机和申请了语音邮件功能的电话机共用电话线

此安装方法的提示：

• 如果您申请了特色铃声服务，此安装方法的效果最好。在这种情况下，请确认您为打印机设置了正确的特
色铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

• 如果您的电话线上只有一个电话号码，或者您没有申请特色铃声服务，您需要设置打印机手动接收传真
（自动应答关）。

当您接听电话并听到传真信号时，请在电话机上按*9*或手动应答码开始接收传真。

• 您也可以设置打印机自动接收传真（自动应答开），但是当您预期接收传真时，您需要禁用语音邮件服
务。如果您使用语音邮件的频率高于传真，此设置效果最好。
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方法 2：数字用户线路(DSL)
如果您使用了数字用户线路(DSL)，请按照此方法进行安装。

数字用户线路(DSL)将您的常规电话线分成两个通道：语音和互联网。电话和传真信号通过语音通道传输，而
互联网信号通过另一个通道传输。在这种情况下，您可以使用同一条线路实现模拟语音电话（包括传真）和数
字互联网连接。

如要使两个通道之间的干扰最小并确保高质量的连接，您需要为网络中的模拟设备（传真机、打印机、电话答
录机）安装一个 DSL 过滤器。干扰会引起电话噪音和静电、打印机传真失败和质量差、计算机的互联网连接
速度慢等问题。

如要为打印机安装一个过滤器：

1 将 DSL 过滤器的线路插口连接在墙壁插座上。

2 使用一根电话线连接打印机后面的  插口和 DSL 过滤器的电话插口。

3 如要继续使用计算机访问互联网，请将计算机连接在 DSL 过滤器的 DSL HPN 插口上。
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方法 3：VoIP 电话服务

如果您从 IP 语音(VoIP)供应商申请了电话服务，请按照此方法进行安装。

此安装方法的提示：

• 将打印机连接在 VoIP 适配器上标有“电话线 1”或“电话插口”的插口上。标有“电话线 2”或“传真插
口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向您的 VoIP 供应商支付额外的
费用。

• 如要确认 VoIP 适配器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号
音。如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

注意：请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部
模拟电话机连接在分线器上，然后收听拨号音。
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方法 4：通过电缆供应商的数字电话服务

安装方法 1：打印机直接连接在电缆调制解调器上

如果您通常将电话机连接在电缆调制解调器上，请按照此安装方法进行操作。

此安装方法的提示：

• 将打印机连接在电缆调制解调器上标有“电话线 1”或“电话插口”的插口上。标有“电话线 2”或“传
真插口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向您的电缆供应商支付额外
的费用。

• 如要确认电缆调制解调器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号
音。如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

注意：请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部
模拟电话机连接在分线器上，然后收听拨号音。
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安装方法 2：打印机连接在墙壁电话线插座上；电缆调制解调器安装在房间中的其他地方

如果您的电缆供应商启用了您的房间中的墙壁电话线插座，您不需要将您的设备连接在电缆调制解调器上，请
按照此安装方法进行操作。您的电缆电话服务来自于墙壁电话线插座。

方法 5：不同国家或地区的特定安装

不同的国家或地区有不同的墙壁电话线插座。被大多数国家或地区所采用的标准墙壁电话线插座是 Registered
Jack-11(RJ-11)。您需要一个 RJ-11 插头，或者一根带有 RJ-11 插头的电话线，以便将设备连接在 RJ-11 墙
壁电话线插座上。

打印机后面的传真插口和随同打印机一起提供的电话线都是 RJ-11 的。如果您所在的国家或地区使用不同类
型的插座，您可能需要使用 RJ-11 适配器。
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将打印机连接在非 RJ-11 墙壁电话线插座上

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ-11 适配器上，然后将适配器插入墙壁电话线插座中。

3 如果您希望将其他设备（电话机或电话答录机）连接在同一个墙壁电话线插座上，并且设备的插头不是
RJ-11 的，请将它直接连接在墙壁电话线插座上。

注意：

• 请不要从打印机后面的  插口上去掉保护塞。

• 在您的国家或地区，打印机包装箱内可能不包含 RJ-11 适配器。
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如果其他设备（电话机或电话答录机）有 RJ-11 插头，您可以从打印机后面的  插口上去掉保护塞，然后将
设备连接在此插口上。

在使用串行连接的国家或地区连接打印机

在一些国家或地区，您需要将所有的设备连接在墙壁电话线插座上。您不能将电话机或电话答录机连接在打印
机的  插口上。这种方法称为串行连接。

澳大利亚 德国 葡萄牙

比利时 爱尔兰 西班牙

丹麦 意大利 瑞典

法国 荷兰 瑞士

芬兰 挪威 英国

警告—可能的损坏：如果您所在的国家或地区包含在列表中，请不要从打印机后面的  插口上去掉保护塞。
如要使电话线上的设备正常工作，此保护塞是必需的。
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如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

将打印机连接在墙壁电话线插座上（德国）

德国的墙壁电话线插座有两种插口。N 插口用于传真机、调制解调器和电话答录机。F 插口用于电话机。
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将打印机连接在任意的 N 插口上。

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ-11 适配器上，然后将适配器插入 N 插口中。

3 如果您希望将电话机和电话答录机连接在同一个墙壁电话线插座上，请按照图示连接设备。

输入您的使用者信息

您的使用者信息包括您的姓名或您的公司名称、您的传真号码（您的传真号码就是您的电话号码，除非您使用
的是专用的传真电话线）和当您发送传真时您的传真机上的日期和时间。此信息出现在您发送的传真的页眉和
页脚中。

在一些国家／地区中，没有此信息您将不能发送传真。一些传真机还会阻止没有发件人信息的传真，因此请确
认您在您的打印机上输入了此信息。

设置传真页眉

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 再次按  按钮选择“您的传真名称”。

5 使用数字符号键区的按钮输入您的姓名或您的公司名称，然后按  按钮。

6 反复按箭头按钮选择“您的传真号码”，然后按  按钮。

7 使用数字符号键区的按钮输入您的传真号码或您的电话号码，然后按  按钮。
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设置传真页脚

1 按  按钮。

2 反复按箭头按钮选择“传真打印”，然后按  按钮。

3 反复按箭头按钮选择“传真页脚”，然后按  按钮。

4 再次按  按钮选择“开”。

5 在您的打印机的初始安装过程中会提示您输入日期和时间。如果您没有输入此信息，请按照以下的步骤进
行操作：

a 按两次  按钮。

b 反复按箭头按钮选择“设备设置”，然后按  按钮。

c 反复按箭头按钮选择“日期／时间”，然后按  按钮。

d 使用数字符号键区的按钮输入日期，然后按  按钮。

e 使用数字符号键区的按钮输入时间，然后按  按钮。

配置传真设置
您可以使用打印机操作面板或传真软件配置传真设置。如果您在打印机操作面板上配置了传真设置，传真软件
将会导入这些设置。所做的改变将会在您下一次运行传真软件时生效。打印机也会保存您在传真软件中选择的
设置，除非您设置打印机阻止从计算机上进行改变。

使用打印机操作面板配置传真设置

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 使用菜单中的选项配置传真设置：

使用此菜单项： 您可以：

通讯簿 设置、查看或打印通讯簿。

报告 • 打印活动日志。活动日志可以允许您查看您的打印机发送和接收传真的历史记录。

• 打印确认页或发送报告。这些报告可以帮助您了解您发送的传真是否成功。

铃声和应答 • 设置打印机自动或手动接收传真。启用或禁用自动应答。

• 调整铃声音量。

• 设置铃响数目。如果您选择了自动接收传真（自动应答开），这是非常重要的。

• 设置特色铃声。如果您为您的电话线申请了特色铃声功能，请在此菜单中为打印机设置正
确的模式。

• 启用传真转发。

• 设置手动应答码。当您手动接收传真时需要按此应答码。

• 设置您希望的来电显示模式。一些国家或地区有多种模式。

传真打印 • 设置打印机打印接收到的传真，使传真适合页面。

• 设置传真页脚。
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使用此菜单项： 您可以：

拨号和发送 • 设置您的传真名称和传真号码。

• 调整拨号音量。

• 设置拨号方法、重拨时间、尝试重拨次数、拨号前缀和传真发送速度。

• 将发送的传真转换为接收传真机可以识别的模式。否则，这样的传真将会失败。

• 在发送过程中启用错误修正。

• 设置打印机在拨打收件人号码之前或之后扫描文档原件。

如果您设置打印机在拨号之前扫描，当传真失败时您不必重新扫描文档。扫描的文档保存
在打印机内存中。打印机可以读取出来，然后自动重拨号码。

如果您设置打印机在拨号之后扫描，打印机不会自动重拨，即使电话线占线。

阻止传真 阻止不希望接收的传真来电。

使用传真软件配置传真设置

在您打开传真软件并配置传真设置之前，请确认：

• 打印机正确地连接在电话线上。

• 打印机的电源已打开，并且连接在计算机上。

• 打印机没有处于省电模式。如果打印机处于节约能源模式，请按  按钮启动打印机。

在 Windows 中使用传真设置向导

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > “传真”选项卡 > 设置打印机进行传真

“传真设置向导”将会出现。

4 按照“传真设置向导”中的指导进行操作。请确认您选择了正确的电话服务和连接。向导将会根据您的连
接配置最佳的传真设置。

注意：如果您希望配置高级传真设置，请在“打印机主页”的“传真”选项卡中单击“配置高级传真设置”。
打印机设置应用程序将会打开。

在 Macintosh（英文版）中使用传真设置应用程序

1 在 Finder 桌面上双击打印机文件夹。

2 双击您的打印机的 Fax Setup Utility 图标。

3 使用软件配置传真设置。

如要获取更多的信息，请单击“帮助”或  浏览有关传真软件的帮助信息。
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创建联系人列表
您可以使用打印机操作面板上的通讯簿或传真软件中的电话簿创建联系人列表。如果您在打印机操作面板上创
建了联系人列表，传真软件将会自动将这些联系人保存为“快速拨号”记录。同样，当您在传真软件中向“快
速拨号”列表中添加联系人时，打印机也会自动将它们保存到打印机通讯簿中。

您最多可以在联系人列表中保存 89 个联系人和 10 个传真群组。

使用打印机操作面板创建联系人列表

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 再次按  按钮选择“通讯簿”。

4 如要向您的通讯簿中添加传真号码：

a 反复按箭头按钮选择“添加”。

b 按  按钮。

c 再次按  按钮选择快速拨号编号。

注意：编号 1–89 用于单个联系人。编号 90–99 用于群组联系人。当您发送传真时，您可以输入快
速拨号编号，不必输入您的联系人的传真号码。

d 使用数字符号键区的按钮在“输入号码”字段中输入传真号码，然后按  按钮。

e 使用数字符号键区的按钮在“输入名称”字段中输入联系人姓名，然后按  按钮保存记录。

f 根据您的需要重复步骤 4b 到 4e 添加其他的记录。您最多可以输入 89 个传真号码。

5 如要添加传真群组：

a 按  按钮选择“添加”。

b 使用数字符号键区的按钮输入 90–99 之间的任意数字，然后按  按钮。

c 在“输入号码”字段中输入传真号码，然后按  按钮。

d 如果您希望向群组中添加其他的联系人，请反复按箭头按钮选择“是”，然后按  按钮。

e 根据您的需要重复步骤 5d。您最多可以为群组输入 30 个传真号码。

如果您不希望添加其他的传真号码，请按  按钮选择“否”。

f 在“输入名称”字段中输入群组名称，然后按  按钮保存记录。

使用传真软件创建联系人列表

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > “传真”选项卡 > 编辑联系人列表

打印机设置应用程序的“联系人”选项卡将会出现。

4 单击“从电话簿中选择”。
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5 从“电话簿”下拉列表中选择电话簿。

6 选择您希望添加的联系人，然后单击“添加到列表或改变列表”导入联系人。

注意：如要添加联系人，您需要从传真软件支持的您的计算机上的通讯簿中导入联系人。除了软件通讯簿
以外，可能还有您的计算机上安装的本地邮件客户端软件（例如 Microsoft Outlook）的电话簿。

7 单击“确定”。

Macintosh（英文版）用户

1 在 Finder 桌面上双击打印机文件夹。

2 双击您的打印机的 Fax Setup Utility 图标。

3 单击 Speed Dials 选项卡。

• 如要添加联系人，请单击 Individuals 选项卡。

• 如要添加传真群组，请单击 Groups 选项卡。

4 单击  打开通讯簿。

注意：如要添加联系人，您需要从您的 Macintosh 计算机上的通讯簿中导入联系人。如果联系人不在 Mac
通讯簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到 Speed Dial 列表中。

如要获取更多的信息，请单击“帮助”或  浏览有关传真软件的帮助信息。

发送传真

自动文档传送器(ADF) 扫描仪玻璃

自动文档传送器(ADF)适用于多页的文档。

注意：ADF 只在某些型号上才有。如果您购买的打印机
没有 ADF，请将文档原件或照片放置在扫描仪玻璃上。

扫描仪玻璃适用于单页的文档、较小的物体（例如明信
片或照片）、透明胶片、照片纸或较薄的介质（例如杂
志剪辑）。
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发送传真提示

在您发送传真之前：

• 请确认打印机的电源已打开，并且连接在可用的电话线、DSL 或 VoIP 线上。如果您可以听到拨号音，说
明线路可以使用。

• 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

• 当使用自动文档传送器时，请调节 ADF 输入托盘上的进纸导轨，使之和文档原件的宽度相同。

• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描结果中出现黑边。

使用打印机操作面板发送传真

1 按打印机操作面板上的  按钮。

2 输入或选择传真收件人：

• 输入传真号码，然后按  按钮。

• 按“通讯簿”按钮从快速拨号列表或群组拨号列表中选择号码，然后按两次  按钮。

3 如果您希望将传真发送给一组收件人（群组传真），请反复按箭头按钮选择“是”，然后按  按钮。

输入下一个号码或者从通讯簿中选择号码。

重复此步骤添加更多的收件人。

4 按“彩色／黑白”按钮选择彩色或黑白传真。

5 按  按钮开始传真作业。

提示：

• 您最多可以发送群组传真给 30 个收件人。

使用计算机发送传真

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 从“打印机名称”下拉列表中选择您的打印机的传真版本，然后单击“确定”。

“发送传真”向导将会出现。

3 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择您的打印机的传真版本。

注意：如要在 Print 对话框中看到传真选项，您必须使用您的打印机的传真驱动程序。如果打印机的传真
版本不在列表中，请单击 Add a printer，然后选择打印机的传真版本。

3 输入收件人的姓名和号码。

4 单击 Fax。
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接收传真

接收传真提示

当您接收传真时：

• 请确认打印机的电源已打开，并且连接在可用的电话线、DSL 或 VoIP 线上。如果您可以听到拨号音，说
明线路可以使用。

• 如果您设置打印机手动接收传真（自动应答关），请确认铃声音量没有设置为“关”。

• 如果您设置打印机自动接收传真（自动应答开），请在打印机内装入纸张。

自动接收传真

1 请确认“自动应答”已启用：

a 按打印机操作面板上的  按钮。

b 反复按箭头按钮选择“传真设置”，然后按  按钮。

c 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

d 再次按  按钮选择“自动应答”。

e 如果“自动应答”没有设置为“开”，请反复按箭头按钮选择“开”，然后按  按钮保存设置。

2 设置打印机应答传真来电之前的铃响数目：

a 反复按箭头按钮选择“何时应答”，然后按  按钮。

b 反复按箭头按钮选择您希望的铃响数目，然后按  按钮保存设置。

当检测到设定数目的铃响之后，打印机开始自动接收传真。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或  和  插口。

提示：

• 如果打印机和其他模拟设备（电话机、电话答录机）共用电话线，请设置打印机比电话答录机多 2 声铃响
应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在
这种情况下，电话答录机首先应答来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上
的传真信号并接管来电。如果打印机使用的是专用传真线路，您可以设置打印机在任意数目的铃响之后应
答来电。

• 如果您在一条电话线上有多个号码，或者您申请了您的电话公司提供的特色铃声服务，请确认您为打印机
设置了正确的特色铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

手动接收传真

1 禁用“自动应答”：

a 按打印机操作面板上的  按钮。

b 反复按箭头按钮选择“传真设置”，然后按  按钮。

c 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

d 再次按  按钮选择“自动应答”。

e 反复按箭头按钮选择“关”，然后按  按钮。
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2 当电话铃响，并且您接听电话听筒时听到了传真信号，请按打印机上的  按钮，或者在连接在打印机上的
电话机上按*9*键。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或  和  插口。

提示：

• 默认的手动应答传真代码为*9*，但是为了更加安全，您可以将它改变为只有您知道的代码。您最多可以输
入 7 个字符。有效的字符包括数字 0-9 和# *符号。

• 请确认电话机连接在打印机后面的  插口上，并且打印机通过  插口连接在墙壁电话线插座上。

传真常见问答

如果我跳过了初始传真设置，我需要重新运行安装程序并设置传真吗？

您不需要重新运行安装程序。您可以使用随同打印机软件一起安装的传真软件设置和配置传真。

如要设置传真：

1 将打印机连接在电话线上。请参阅第 62 页“设置打印机进行传真”获取更多的信息。

2 使用传真软件配置传真设置。

Windows 用户

a 单击  或“开始”。

b 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

c 依次选择：

打印机主页 > “传真”选项卡 > 设置打印机进行传真

“传真设置向导”将会出现。

d 按照“传真设置向导”中的指导进行操作。请确认您选择了正确的电话服务和连接。向导将会根据您的
连接配置最佳的传真设置。

Macintosh（英文版）用户

a 在 Finder 桌面上双击打印机文件夹。

b 双击您的打印机的 Fax Setup Utility 图标。

c 配置传真设置。

什么是分线器？我应该使用什么类型的分线器？

如果您家中的墙壁电话线插座数量有限，或者您的适配器上的插口数量有限，您可以使用电话分线器。分线器
可以将电话信号分成几部分，允许您在墙壁电话线插座上连接多个设备。分线器上有两个或多个插口，您可以
将设备连接在插口上。请不要使用线路分线器。

如要确认您使用的是正确的分线器，请将一部模拟电话机连接在分线器上，然后收听拨号音。
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什么是我的传真号码？

大多数情况下，您的电话号码也就是您的传真号码。如果您申请了电话公司提供的特色铃声模式检测(DRPD)
服务，则您的传真号码是您为打印机指定的号码。请确认您在传真软件或打印机操作面板的“传真设置”菜单
中为此号码输入了正确的特色铃声模式。

如果您有多条电话线，请确认您输入了打印机所连接的线路的号码。

什么是我的拨号前缀？

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果打
印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。如果您要
向外地发送传真，则您需要输入国家代码或地区代码。如果您需要经常向同一个国家或地区发送传真，拨号前
缀功能非常有用。当您在应用程序中设置拨号前缀后，您不需要每次拨打传真号码或电话号码时都按此数字。
打印机可以在您每一次拨号时自动输入前缀。

您最多可以输入 8 个字符作为您的拨号前缀。有效的字符包括数字 0-9 和以下符号：#和*。如果您使用传真软
件输入拨号前缀，您也可以输入以下字符：点(.)、逗号(,)、星号(*)、井号(#)、加号(+)、减号(-)和圆括号。

我什么时候需要启用“自动应答”？

如果您希望打印机自动接收传真，请启用“自动应答”。

如果打印机与电话答录机连接在同一条电话线上，则您必须启用“自动应答”，以便您可以同时接收您的语音
来电和传真。请确认设置电话答录机在较少数目的铃响（与打印机设置相比）之后应答来电。这样可以让其他
设备首先应答语音来电。如果来电是传真，打印机可以在线路上检测到传真信号并应答来电。

我应该设置多少声铃响？

如果打印机和电话答录机共用电话线，请设置打印机在较多数目的铃响之后应答来电。因为您只有一条线路，
没有办法区分语音来电和传真来电。您可以通过设置铃响数目让电话答录机接收语音来电，让打印机接收传真
来电。如果您设置其他的设备在较少数目的铃响之后应答来电，则设备先应答来电，可以接收语音来电。如果
来电是传真，打印机可以检测到并接管来电。

如果打印机使用的是专用传真线路，您可以设置打印机在您希望的任意数目的铃响之后应答来电。

我如何为打印机设置特色铃声？

如果您申请了电话公司提供的特色铃声模式检测(DRPD)服务，设置正确的铃声是非常重要的。此功能可以允
许您在一条电话线上拥有多个电话号码。每个电话号码有指定的铃声模式（一声铃响、两声铃响、三声铃
响）。不同的铃声模式可以让您知道拨打的是哪一个电话号码以及您应该使用哪一个设备应答来电。

将您的电话号码之一指定给打印机作为传真号码，然后设置打印机应答该号码的铃声模式。如果铃声模式设置
不正确，打印机会响铃，但是不会接收传真。

如要为打印机设置铃声模式：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“铃声和应答”，然后按  按钮。
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4 反复按箭头按钮选择“铃声模式”，然后按  按钮。

5 反复按箭头按钮为打印机选择铃声模式，然后按  按钮。

特色铃声也称作 Ident-a-Call、Smart Ring、Teen Ring、RingMaster 和 IdentaRing。

我如何检查拨号音？

拨号音可以帮助您知道电话线是否可以使用以及打印机是否正确地连接在电话线上。如果您发送和接收传真时
遇到了问题，请确认您可以在电话线上和通过打印机听到拨号音。

请确认电话线和墙壁电话线插座都可用

1 将一部模拟电话机连接在墙壁电话线插座上。

2 通过电话听筒收听拨号音。

如果您听到了拨号音，说明电话线和墙壁电话线插座可以使用。

如果您没有听到拨号音，请将模拟电话机连接在另一个墙壁电话线插座上，然后收听拨号音。如果您听到
了拨号音，说明电话线可以使用，但是第一个墙壁电话线插座不能使用。

请确认打印机正确地连接在电话线上

1 当打印机通过后面的  插口连接在电话线上时，将一部模拟电话机连接在打印机的  插口上。

2 收听拨号音。

如果您听到了拨号音，说明电话线可以使用，并且正确地连接在打印机上。

如果您通过墙壁电话线插座和打印机都没有听到拨号音，请参阅第122 页“传真问题解答注意事项”。

我如何调整打印机的扬声器音量？

收听拨号音可以检查电话线是否可以使用，并检查电缆和设备是否正确地连接在您的电话网络中。请确认拨号
音量没有设置为“关”，特别是当您使用免提拨打号码时。如果您设置打印机手动接收传真，请确认您设置的
铃声音量足够大，以便您能听到。

调整拨号音量

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 反复按箭头按钮选择“拨号音量”，然后按  按钮。

5 反复按箭头按钮选择拨号音量设置，然后按  按钮。

调整铃声音量

1 按  按钮返回到“传真设置”菜单。

2 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

3 反复按箭头按钮选择“铃声音量”，然后按  按钮。

4 反复按箭头按钮选择铃声音量设置，然后按  按钮。
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我如何确保打印机应答传真来电，而电话答录机应答语音来电？

如要确保打印机应答传真来电，请将“自动应答”设置为“开”，然后设置打印机在较多数目的铃响之后应答
来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在这种情
况下，电话答录机首先应答来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上的传真信号
并接管来电。

什么设置最适用于数字语音邮件？

如果您申请了特色铃声服务，语音邮件和传真可以共用同一条电话线。此功能可以允许您在一条电话线上拥有
多个电话号码。每个电话号码有指定的铃声模式（一声铃响、两声铃响、三声铃响）。不同的铃声模式可以让
您知道拨打的是哪一个电话号码以及您应该使用哪一个设备应答来电。

如果您没有特色铃声服务，请设置打印机手动接收传真（禁用“自动应答”）。此设置可以允许您同时接收语
音来电和传真来电，但是，如果您更常用语音邮件的话效果最好。每次您预期接收传真时，您都需要禁用语音
邮件。

我如何改变传真文档的分辨率？

您发送的文档的分辨率或传真质量可能会影响传真的发送。接收传真机可能不支持高分辨率并且可能无法接收
您的传真。您可以通过启用“自动传真转换”解决此问题，但是自动转换可能会导致传真不清楚，特别是当文
档原件已经很模糊时。

请选择最适合于接收传真机性能和文档原件质量的传真质量。

质量 黑白分辨率 彩色分辨率

标准 200 x 100 200 x 200

较好 200 x 200 200 x 200

更好 300 x 300 200 x 200

最好 300 x 300（点调和） 200 x 200

当您发送传真时，输入传真号码之后请反复按箭头按钮选择传真质量，然后按  按钮。

我如何在预定的时间发送传真？

1 按打印机操作面板上的  按钮。

2 输入或选择传真收件人：

• 输入传真号码，然后按  按钮。

• 按“通讯簿”按钮从快速拨号列表或群组拨号列表中选择号码，然后按两次  按钮。

3 如果您希望将传真发送给一组收件人（群组传真），请反复按箭头按钮选择“是”，然后按  按钮。

输入下一个号码或者从通讯簿中选择号码。

重复此步骤添加更多的收件人。

4 反复按  按钮选择“定时传真”。

5 反复按箭头按钮选择“稍后发送”，然后按  按钮。

6 输入您希望发送传真的时间，然后按  按钮。
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7 如果打印机没有设置为 24 小时模式，请反复按箭头按钮选择“上午”或“下午”，然后按  按钮。

8 按  按钮开始扫描文档并保存定时传真。

打印机将会在预定的时间发送传真。在预定的时间之前，请不要关闭打印机或将打印机从电话线上断开。

9 如果您希望在传真中包含其他页面，请反复按箭头按钮选择“是”，然后按  按钮。

我如何使用电话卡发送传真？

1 按“拨号音”按钮。

您应该可以听到电话线的拨号音。

2 输入电话卡信息，当您连接到电话运营商时，请按照提示进行操作。

3 当听到提示后，请输入收件人的传真号码，然后按  按钮。

我如何知道传真是否发送成功？

您可以设置打印机在您每一次发送传真后打印确认页或发送报告。此报告包括发送传真的日期和时间。如果传
真作业不成功，则报告中也包括错误原因。

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“报告”，然后按  按钮。

4 反复按箭头按钮选择“确认”，然后按  按钮。

5 反复按箭头按钮选择打印报告选项：

• 如果您希望每一次发送传真后都打印报告，请选择“全部”或“全部打印”。

• 如果您希望节省墨水，只在传真作业不成功时打印报告，请选择“出错时”。

6 按  按钮。

我如何查看打印机的传真历史记录？

您可以打印已发送和／或已接收传真的报告。

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“报告”，然后按  按钮。

4 反复按箭头按钮选择“活动报告”，然后按  按钮。

5 如要设置何时打印传真活动报告，请反复按箭头按钮选择在 40 份传真之后或者只在要求时打印传真活动
报告。

6 如要打印传真活动报告，请反复按箭头按钮选择“打印报告”，然后按  按钮。

• 如要只打印发送传真历史记录，请反复按箭头按钮选择“发送日志”，然后按  按钮。

• 如要只打印接收传真历史记录，请反复按箭头按钮选择“接收日志”，然后按  按钮。

• 如要打印发送和接收传真历史记录，请反复按箭头按钮选择“活动报告”，然后按  按钮。
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我如何转发传真？

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

4 反复按箭头按钮选择“传真转发”，然后按  按钮。

5 反复按箭头按钮选择“转发”或“打印并转发”，然后按  按钮。

6 使用数字符号键区的按钮输入您希望将传真转发到哪个号码，然后按  按钮。

当您启用此选项后，所有您接收到的传真将会自动转发，直到您禁用此选项。

如要禁用传真转发，请返回到“传真转发”菜单，然后选择“关”。

我可以阻止传真吗？

您可以阻止来自特定号码的传真。您也可以阻止垃圾传真和来自无法识别的发件人（没有来电号码的发件人）
的传真。如果您希望自动接收传真，但是希望过滤您接收的传真，此功能特别有用。

1 启用阻止传真功能。

a 按打印机操作面板上的  按钮。

b 反复按箭头按钮选择“传真设置”，然后按  按钮。

c 反复按箭头按钮选择“阻止传真”，然后按  按钮。

d 反复按箭头按钮选择“打开／关闭”，然后按  按钮。

e 反复按箭头按钮选择“开”，然后按  按钮保存设置。

2 添加要阻止的号码。

a 反复按箭头按钮选择“添加”。

b 按  按钮。

c 使用数字符号键区的按钮输入传真号码，然后按  按钮保存。

d 使用数字符号键区的按钮输入您希望阻止的发件人的姓名。

e 重复步骤 2b 到 2d，直到您添加了所有您希望阻止的号码。您最多可以阻止 50 个号码。

3 阻止无法识别的传真（没有来电号码的传真）。

a 反复按箭头按钮选择“阻止无号码”，然后按  按钮。

b 反复按箭头按钮选择“开”，然后按  按钮保存设置。

我可以找回失败的传真吗？

打印机在打印接收到的传真之前会将传真保存在打印机内存中。如果打印机在接收传真时墨水用完了或者纸张
用完了，您可以在解决错误之后继续打印传真。如果有要打印的传真，打印机将会提示您。

如果接收的传真或发送的传真由于断电丢失了，打印机将会在下一次开机时自动打印错误报告。对于接收的传
真，错误报告可以让您知道发件人是谁以及还有多少页没有打印。对于发送的传真，错误报告可以让您知道还
有多少页没有发送。由于断电丢失的传真无法找回。
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网络

在无线网络中安装打印机

无线网络兼容性

您的打印机可能包含 IEEE 802.11b、IEEE 802.11g 或 IEEE 802.11n 无线打印服务器。您的打印机可以兼容
经过 Wi-Fi 认证的 IEEE 802.11 b/g/n 路由器。

注意：如果您的打印机带有一个 IEEE 802.11g 无线打印服务器，并且当您使用 n 路由器时出现了问题，请向
您的路由器制造商确认当前的模式设置是否兼容 g 设备，因为此设置根据不同的路由器品牌或型号而不同。

可支持的网络安全性选项

打印机支持三种无线安全性选项：无安全性、WEP 和 WPA／WPA2。

无安全性

我们不推荐您在家用无线网络中根本不使用安全性。不使用安全性意味着您的无线网络范围内的所有人都可以
使用您的网络资源——包括 Internet 访问（如果您的无线网络可以连接到 Internet）。您的无线网络的范围可
能会超出您的住所的墙壁，导致在街道上或者在您的邻居家中可以访问您的网络。

WEP

WEP（有线等效加密）是最基本和最薄弱的无线安全性。WEP 安全性依靠一系列字符来实现，称为 WEP 密
钥。

无线网络中的所有设备都必须使用相同的 WEP 密钥。WEP 安全性可以用于 Ad hoc 网络和 Infrastructure 网
络。

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。

WPA／WPA2

WPA（Wi-Fi 保护访问）和 WPA2（Wi-Fi 保护访问 2）可以提供比 WEP 更强的无线网络安全性。WPA 和
WPA2 是类似的安全性。WPA2 使用更复杂的加密方法，比 WPA 更安全。WPA 和 WPA2 都使用一系列字符
（称为 WPA 预共享密钥或密码短语）来保护无线网络，避免遭受未经授权的访问。

有效的 WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。
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无线网络中的所有设备都必须使用相同的 WPA 密钥。WPA 安全性只能用于使用接入点（无线路由器）和支
持 WPA 的网卡的 Infrastructure 网络。大多数比较新的无线网络设备也可以选择使用 WPA2 安全性。

注意：如果您的网络使用 WPA 或 WPA2 安全性，当提示您选择您的网络所使用的安全性类型时，请选
择“WPA 个人”。

打印网络设置页

网络设置页列出了您的打印机的配置设置，包括打印机的 IP 地址和 MAC 地址。

1 装入普通纸。

2 按打印机操作面板上的  按钮。

3 反复按箭头按钮选择“网络设置”，然后按  按钮。

4 按  按钮选择“打印设置页”。

打印机将会打印出一张网络设置页。

在无线网络中安装打印机所需的信息

如要安装打印机以实现无线打印，您需要知道：

• 您的无线网络的名称，也称为 SSID（服务设置识别码）

• 是否使用了加密措施保护您的网络安全

• 安全密钥（WEP 密钥或 WPA/WPA2 密钥）

如要查找网络 WEP 密钥或 WPA/WPA2 密钥，请查看您的接入点（无线路由器）设置并查看安全性信息。

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。

注意：如果您不知道您的计算机所连接的网络的 SSID，请运行计算机网络适配器的无线应用程序并查找网络
名称。如果您无法找到您的网络的 SSID 或安全信息，请参阅随同接入点一起提供的帮助文档，或者与您的系
统支持人员联系。

在无线网络中安装打印机

在您在无线网络中安装打印机之前，请确认：

• 您的无线网络已经正确安装且可以正常工作。

• 您要使用的计算机连接在您希望安装打印机的同一个无线网络中。
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Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

c 按 Enter 键，或者单击“确定”。

3 按照“欢迎”界面中的指导安装打印机。

Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 从打印机网站上下载最新的安装程序。

3 运行打印机安装软件，然后按照计算机屏幕上的指导进行操作。

在其他的计算机上安装打印机

当打印机在无线网络中安装完毕后，网络中的任何计算机都可以通过无线访问此打印机。但是，您必须在所有
需要访问打印机的计算机上安装打印机驱动程序。如要安装驱动程序，您需要在每一台计算机上运行设置软
件，但是您不需要重新配置打印机。

Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

c 按 Enter 键，或者单击“确定”。

3 按照计算机屏幕上的指导在新的计算机上安装已配置的打印机。

Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 从打印机网站上下载最新的安装程序。

3 运行打印机安装软件，然后按照计算机屏幕上的指导进行操作。

Wi-Fi 指示灯的颜色说明

Wi-Fi 指示灯的颜色可以显示出打印机的网络状态。

• 不亮表示以下情况之一：

– 打印机的电源已关闭或者正在开机。

– 打印机没有连接在无线网络中并且处于省电模式。在省电模式下，电源指示灯将会闪烁。
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• 持续橙色表示以下情况之一：

– 打印机没有经过配置，无法在无线网络中使用。

– 打印机已经配置了 Ad hoc 连接，但是现在没有和其他的 Ad hoc 设备进行通讯。

• 橙色闪烁表示以下情况之一：

– 打印机超出了无线接入点（无线路由器）的范围。

– 打印机正在尝试与无线接入点进行通讯，但是无线接入点可能已关闭电源或者无法正常工作。

– 已经过配置的打印机或无线接入点关闭了电源并重新打开，并且打印机正在尝试与网络建立通讯。

– 打印机的无线设置可能不再有效。

• 绿色表示打印机连接在一个无线网络中，并且已经准备就绪，可以使用。

特殊的无线安装指导

以下的指导适用于北美洲以外且使用无线宽带 box 的用户。以下是一些 box 的例子：LiveBox、AliceBox、
N9UF Box、FreeBox 和 Club Internet。

在您开始安装之前

• 请确认您的 box 具备无线功能，并且可以在无线网络中使用。有关配置 box 以便在无线网络中使用的更多
帮助信息，请参阅随同您的 box 一起提供的说明文档。

• 请确认您的 box 的电源已打开，并且您的计算机已打开并连接在您的无线网络中。

向您的无线网络中添加打印机

1 使用提供的安装指导在无线网络中安装您的打印机。

当提示您选择网络时，请停止操作。

2 如果您的 box 后面有一个关联／注册按钮，请在选择网络之前按此按钮。

注意：按关联／注册按钮之后，您有 5 分钟时间完成打印机的安装。

3 返回到计算机屏幕。

从显示的无线网络列表中选择您的网络，然后单击“继续”。

如果您的无线网络没有显示在列表中：

a 连接到其他的无线网络。

Windows 用户

单击“未列出的网络”。

Macintosh（英文版）用户

从列表中选择 Other Wireless Network，然后单击 Continue。

b 输入有关您的无线网络的详细资料。

注意：您可以从 box 的底部、随同 box 一起提供的帮助文档或者 box 的网页获得 WEP、WPA 或
WPA2 密钥。如果您已经改变了您的无线网络的密钥，请使用您创建的密钥。

4 按照计算机屏幕上的指导进行操作。
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指定静态 IP 地址

在大多数的无线网络中，打印机将会通过 DHCP 自动分配一个 IP 地址。

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

注意：如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开打印机网页。

4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

如要确认，请在网页浏览器的地址栏中输入静态 IP 地址，然后按 Enter 键。

如要获取更多的信息，请与您的系统支持人员联系。

安装后改变无线设置

如要改变打印机的无线设置（例如配置的网络和安全密钥），请根据您的操作系统选择操作：

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

高级无线设置

创建 Ad hoc 无线网络

如果您满足以下条件，您可以安装一个 Ad hoc 网络：

• 没有无线接入点或无线路由器

• 没有无线网络（但是您的计算机带有无线网络适配器）

• 希望在打印机和带有无线网络适配器的计算机之间安装一个独立的网络
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注意：

• 在您开始操作之前，请确认您的无线网络适配器正确地连接在您的计算机上，并且可以正常工作。

• 我们推荐您使用接入点（无线路由器）安装您的无线网络。这种网络安装称为 Infrastructure 网络。

• 如果您的计算机有“MyWi-Fi”或“Wi-Fi Direct”，您可以建立直接连接到您的无线打印机。请参阅您的
计算机的帮助文档获取更多的信息。

• 打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机可以避免打印机在其他的
无线网络（Ad hoc 或 Infrastructure）中工作。

Windows Vista 或更高版本

1 单击“  > 控制面板 > 网络和 Internet > 网络和共享中心”。

2 单击“安装连接或网络 > 安装无线点对点（计算机到计算机）网络 > 下一步”。

3 按照有关设置无线 Ad hoc 网络的指导进行操作。在安装过程中：

a 为计算机和您的打印机之间的网络创建一个网络名称或 SSID。

b 记录下您的网络名称。请确认您准确地记录了所有的内容，包括大写字母。

c 从“安全类型”下拉列表中选择“WPA2 个人”或“WEP”，然后创建一个 WPA 密钥或 WEP 密钥。

WPA 密钥必须为：

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

或者

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

WEP 密钥必须为：

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。

或者

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

d 记录下您的网络密码。请确认您准确地记录了所有的内容，包括大写字母。

Windows Vista 将会为您启用 Ad hoc 网络，并且显示在“连接到网络”对话框中的可用网络中，表示计算
机已经完成了 Ad hoc 网络的配置。

4 关闭 Windows 控制面板和所有其他的窗口。

5 插入安装软件光盘，然后按照计算机屏幕上的指导进行无线安装。

注意：请不要连接安装或网络电缆，直到安装软件提示您这样做。

6 当可用的网络显示出来后，请提供您创建的网络名称和安全信息。应用程序将会配置打印机，以便连接您
的计算机使用。

7 将您的网络名称和安全信息保存在安全的地方，以备将来使用。

注意：Windows Vista 计算机重新启动之后，您可能需要重新将它连接到 Ad hoc 网络中。

Windows XP

1 单击“开始 > 控制面板 > 网络和 Internet 连接 > 网络连接”。

2 右键单击“无线网络连接”图标。
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3 如果弹出菜单中包含“启用”，请单击它。

注意：如果弹出菜单中包含“停用”，说明您的无线连接已经启用了。

4 右键单击“无线网络连接”图标。

5 单击“属性 > 无线网络选项卡”。

注意：如果“无线网络”选项卡没有出现，说明您的计算机使用第三方的软件来控制您的无线设置。您必
须使用该软件设置 Ad hoc 无线网络。请参阅第三方软件的帮助文档获取更多的信息。

6 选中“用 Windows 来配置我的无线网络设置”复选框。

7 在“首选网络”下面，删除所有现有的网络。

选择网络，然后单击“删除”从列表中删除网络。

8 单击“添加”创建一个 Ad hoc 网络。

9 在“服务名(SSID)”框中输入您希望的无线网络名称。

10 记录下您输入的网络名称，当您进行无线设置的时候可能会需要此信息。请确认您准确地记录了所有的内
容，包括大写字母。

11 如果列表中出现“网络身份验证”，请选择“打开”。

12 从“数据加密”列表中选择“WEP”。

13 如有必要，请取消选中“自动为我提供此密钥”复选框。

14 在“网络密钥”框中输入 WEP 密钥。

15 记录下您输入的 WEP 密钥，当您进行无线设置的时候可能会需要此信息。请确认您准确地记录了所有的
内容，包括大写字母。

16 在“确认网络密钥”框中输入相同的 WEP 密钥。

17 选中“这是一个计算机到计算机（特定的）网络；没有使用无线访问点”复选框。

18 单击两次“确定”关闭打开的窗口。

19 您的计算机可能需要几分钟来识别新的设置。如要检查您的网络的状态：

a 右键单击“无线网络连接”图标。

b 单击“查看可用的无线连接”。

• 如果网络已列出，但是计算机没有连接，请选择 Ad hoc 网络，然后单击“连接”。

• 如果网络没有出现，请等待一会儿，然后单击“刷新”。

20 插入安装软件光盘，然后按照计算机屏幕上的指导进行无线安装。

注意：请不要连接安装或网络电缆，直到安装软件提示您这样做。

21 当可用的网络显示出来后，请提供您创建的网络名称和安全信息。应用程序将会配置打印机，以便连接您
的计算机使用。

22 将您的网络名称和安全信息保存在安全的地方，以备将来使用。

Windows 2000
• 请参阅随同您的无线网络适配器一起提供的帮助文档获取有关在 Windows 2000 中配置 Ad hoc 网络的信
息。
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Macintosh（英文版）用户

1 读取 Airport 设置：

Mac OS X version 10.5 或更高的版本

从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

Mac OS X version 10.4 或更早的版本

从 Finder 中依次选择：

Applications > Internet Connect > AirPort

2 从 Network Name 或 Network 弹出菜单中单击 Create Network。

3 为您的 Ad hoc 网络创建一个名称，然后单击 OK。

注意：将您的网络名称和密码保存在安全的地方，以备将来使用。

向现有的 Ad hoc 无线网络中添加打印机

注意：打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机会将打印机从所有其他
配置过的无线网络（Ad hoc 或 Infrastructure）中删除。

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

注意：Windows Vista 计算机重新启动之后，您可能需要重新将它连接到 Ad hoc 网络中。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

使用 WPS 配置打印机以便无线使用（仅限于 Windows）
使用 Wi-Fi Protected Setup(WPS)可以轻松地将计算机或打印机添加到您的无线网络中，因为它可以自动为您
检测并配置 SSID 和 WPA 密钥。

1 请确认您的接入点（无线路由器）支持 WPS。

2 插入安装软件光盘，然后按照计算机屏幕上的指导进行操作。
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注意：

• 如果您要使用 WPS 识别码方式添加您的打印机，当要求您输入您的识别码时，请确认输入所有的 8 位数
字。

• 如要使用 WPS 配置打印机以便无线使用，您的无线网络中的所有设备都必须支持 WPS。如果您的网络
中有不支持 WPS 的设备，则您必须在出现提示时输入 SSID 和安全性信息。

在 USB 和无线连接之间转换（仅限于 Windows）
您可以根据您的需要改变访问您的打印机的方法。以下的步骤假定您已经按照一种连接类型配置了您的打印
机，并且已经在计算机上安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与该连接类型相关
的问题解答主题。

转换到无线连接

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。

转换到本地(USB)连接

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

注意：您可以继续通过无线连接使用打印机。

在 USB 和无线连接之间转换（仅限于 Macintosh 英文版）

您可以根据您的需要改变访问您的打印机的方法。以下的步骤假定您已经按照一种连接类型配置了您的打印
机。如果您在配置过程中遇到了困难，请参阅与该连接类型相关的问题解答主题。

转换到无线连接

1 关闭所有打开的应用程序。

2 从打印机网站下载最新的安装程序。

3 双击 Dell Extras > Dell Setup Assistant。

4 按照计算机屏幕上的指导配置打印机以便无线使用。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。
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转换到本地(USB)连接

1 将 USB 电缆的一端连接在打印机后面的 USB 接口上。将 USB 电缆的另一端连接在计算机的 USB 接口
上。

2 添加打印机：

Mac OS X version 10.5 或更高的版本：

a 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

b 单击+。

c 单击 Default 选项卡 > 选择您的打印机 > Add。

Mac OS X version 10.4 或更早的版本：

a 在 Finder 桌面上单击 Utilities。

b 双击 Printer Setup Utility 或 Print Center。

c 在 Printer List 对话框中选择您希望使用的打印机，然后单击 Add。

d 从 Printer Browser 中选择您的打印机，然后单击 Add。

3 另一个打印队列将会创建。如果您不希望改回通过无线连接访问打印机，请删除无线队列。

在 Windows 环境下共享一台打印机

1 准备好要共享打印机的计算机：

a 在所有需要进行打印的计算机上启用“文件和打印机共享”，使得这些计算机可以出现在“网上邻
居”中。请参阅 Windows 文档获取有关启用“文件和打印机共享”的指导。

b 在所有需要进行打印的计算机上安装打印机软件。

2 标识打印机：

a 在与打印机相连的计算机上，按照以下的步骤进行操作：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

b 右键单击您的打印机图标。

c 单击“共享”或“打印机属性”。

d 在“共享”选项卡中选择“共享这台打印机”或“共享为”。

e 输入一个不同于其他打印机的名称，然后单击“确定”。

3 在远程计算机上定位打印机：

注意：远程计算机是指没有直接连接打印机的计算机。

a 按照以下的步骤进行操作：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

b 右键单击您的打印机图标。
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c 单击“属性”或“打印机属性”。

d 单击“端口 > 添加端口 > Local Port > 新端口”。

e 输入符合通用命名标准(UNC)的端口名称，包括服务器名称和您在第 94 页中的步骤 2 中指定的打印机
名称。端口名称应该为以下格式：\\服务器\打印机。

f 单击“确定”。

g 在“打印机端口”对话框中单击“关闭”。

h 请确认在“端口”选项卡中选中了新添加的端口，然后单击“应用”。

i 单击“确定”。

在 Macintosh（英文版）环境下共享打印机

1 在 Finder 桌面上单击 Help > Mac Help。

2 在 Search 字段中输入 sharing the printer on a network，然后按 return 键。

3 从以下选项中只选择一项：

• 与 Mac OS X 用户共享您的打印机 — 允许网络中其他使用 Mac OS X version 10.4 或更高版本的
Macintosh 计算机使用连接在您的 Macintosh 计算机上的打印机。

• 与 Windows 用户共享您的打印机 — 允许网络中的 Windows 计算机使用连接在您的 Macintosh 计算
机上的打印机。

4 按照计算机屏幕上的指导进行操作。

注意：Windows 用户可以参阅 Windows 帮助文档获取有关添加网络打印机并连接到 Macintosh 计算机的信
息。

网络常见问答

什么是 Wi-Fi Protected Setup？
Wi-Fi Protected Setup(WPS)是一种简单且安全的配置，可以帮助您建立无线家用网络和启用网络安全性，不
需要提前了解有关 Wi-Fi 技术的知识。您不再需要为网络设备配置网络名称(SSID)和 WEP 或 WPA 密钥。

注意： WPS 只支持通过接入点（无线路由器）进行通讯的网络。

打印机支持以下方法连接到无线网络：

• 个人识别码(PIN) — 将打印机上的识别码输入到接入点的无线设置中。

• 按钮配置(PBC) — 在指定的一段时间内分别按打印机和接入点上的按钮。

查找以下的识别标记可以检查您的接入点是否兼容 WPS：

您可以在您的接入点的侧面、后面或顶部找到这些 WPS 徽标。
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如要获取更多有关读取无线设置和确定您的无线接入点的 WPS 兼容性的信息，请参阅随同接入点一起提供的
帮助文档，或者与您的系统支持人员联系。

哪里可以找到我的 WEP 密钥或 WPA 密钥？
• 与您的系统支持人员联系。

– 安装您的网络的人通常保存着 WEP 密钥或 WPA 密钥。

– 如果您的无线网络是由您的 Internet 服务供应商(ISP)安装的，您可以从他们提供的文档中查找相关的
信息。

• 参阅随同您的接入点（无线路由器）一起提供的帮助文档。

如果您的接入点使用默认设置，您可以在帮助文档中找到相关的信息。

• 在接入点上查看安全性设置。

1 打开网页浏览器，然后在地址栏中输入接入点的 IP 地址。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA 密钥与接入点的密码不同。密码可以允许您访问接入点的设置。WEP 密钥
或 WPA 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA 密钥。

什么是 SSID？

服务设置识别码 (SSID)是用于识别无线网络的一个名称。网络中的所有设备都必须知道无线网络的 SSID，否
则它们将不能互相通讯。通常，无线网络广播其 SSID 以允许区域中的无线设备连接到网络。出于安全原因，
有的时候不会广播 SSID。

SSID 最多可以包含 32 个字母或数字字符。

哪里可以找到我的 SSID？
• 查看接入点（无线路由器）的设置。

大多数接入点带有内置的网络服务器，可以使用网络浏览器访问。

• 检查您的计算机是否为您的无线网络适配器安装了相应的程序。

很多网络适配器提供了软件应用程序，可以允许您查看您的计算机的无线设置，包括您的 SSID。

如果使用这些方法不能找到您的 SSID，请与您的系统支持人员联系。

什么是网络？

网络是指一组通过电缆或无线连接在一起并互相通讯的设备，例如计算机、打印机、以太网集线器、接入点和
路由器。一个网络可以是有线的、无线的、或者同时包含有线和无线设备。
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如何找到我的网络所使用的安全类型？
• 与您的系统支持人员联系。

安装您的网络的人通常保存着您的无线信息。

• 参阅随同您的接入点（无线路由器）一起提供的帮助文档。

• 检查您用于访问您的无线网络的密码所用的字符。

如果您没有使用密码，请选择“无安全性”。

字符 安全类型

10 个或 26 个十六进制字符

或者

5 个或 13 个 ASCII 字符

WEP

64 个十六进制字符

或者

8-63 个 ASCII 字符

WPA 或 WPA2

注意：

– 十六进制字符包括 A–F、a–f 和 0–9。

– ASCII 字符包括字母、数字和可以在键盘上找到的字符。

• 在接入点上查看安全性设置。

1 打开网页浏览器，然后在地址栏中输入接入点的 IP 地址。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA 密钥与接入点的密码不同。密码可以允许您访问接入点的设置。WEP 密钥
或 WPA 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA 密钥。

家用网络如何配置？

台式电脑、便携式笔记本电脑和打印机如要在网络中互相通讯，它们必须连接电缆和／或内置或安装无线网络
适配器。

您可以使用多种不同的方法安装网络。以下是四种普通范例。

注意：下面图中的打印机代表内置了内部打印服务器的打印机，可以在网络中进行通讯。

无线网络范例

方法 1：网络中同时包含有线和无线连接，可以连接到 Internet
• 所有计算机和打印机都通过具有以太网和无线功能的路由器连接在网络中。

• 一些计算机和打印机通过无线连接在路由器上，其他计算机和打印机通过有线连接。
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• 网络通过 DSL 或电缆调制解调器连接到 Internet。

方法 2：无线网络，可以连接到 Internet
• 所有计算机和打印机都通过无线接入点或无线路由器连接在网络中。

• 无线接入点通过 DSL 或电缆调制解调器将网络连接到 Internet。

方法 3：无线网络，不可以连接到 Internet
• 计算机和打印机通过无线接入点连接在网络中。

• 网络不能连接到 Internet。
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方法 4：计算机通过无线连接到打印机，不可以连接到 Internet
• 计算机直接连接到打印机，没有通过无线路由器。

• 这种配置方法称作 Ad hoc 网络。

• 网络不能连接到 Internet。

注意：大多数计算机一次只能连接到一个无线网络。如果您通过无线连接访问 Internet，当您连接到 Ad hoc
网络时，您将无法访问 Internet。

为什么我需要安装电缆？

当在您的无线网络上设置打印机时，打印机将需要使用安装电缆暂时连接到计算机。使用此暂时连接来设置打
印机的无线设置。

我如何连接安装电缆？

安装电缆连接在计算机的 USB 接口和打印机后面的正方形接口中。此连接可以允许您为网络安装或本地连接
安装配置打印机。

1 将较大、矩形的一端连接在您的计算机的任意 USB 接口中。USB 接口可能位于计算机的前面或后面，可
能是水平的或垂直的。
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2 将较小、较方的一端连接在打印机的后面。

3 按照计算机屏幕上的指导继续操作。

Infrastructure 和 Ad hoc 网络之间有什么区别？

无线网络可以按照以下两种模式运行：Infrastructure 模式或 Ad hoc 模式

在 Infrastructure 模式下，无线网络中的所有设备都通过接入点（无线路由器）互相通讯。

在 Ad hoc 模式下，带有无线网络适配器的计算机和带有无线打印服务器的打印机直接进行通讯。

Infrastructure Ad hoc

特征

通讯 通过接入点 直接在设备之间

安全性 更多的安全选项 WEP 或无安全性

范围 取决于接入点的范围和数量 受限于网络中单个设备的范围

速度 通常较快 通常较慢

所有设备的需求

每个设备都有唯一的 IP 地址 是 是

模式设置为 Infrastructure 模式 Ad hoc 模式

相同的 SSID 是，包括接入点 是

相同的频道 是，包括接入点 是

我们推荐您使用安装软件光盘按照 Infrastructure 模式安装网络。Infrastructure 模式可以提供：

• 网络安全性较高

• 可靠性较高
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• 性能较快

• 安装较简易

查找信号强度

无线设备带有内置的天线，可以发送和接收无线信号。打印机网络设置页中的信号强度表示接收到的传输信号
的强度。很多因素可以影响信号强度。一个因素是来自其他无线设备或微波炉等其他设备的干扰。另一个因素
是距离。两个无线设备之间的距离越远，通讯信号就可能越弱。

在配置过程中，您的计算机接收到的信号强度也会影响打印机与网络的连接。当您在计算机内安装了无线适配
器时，适配器软件可能会在您的系统托盘中添加一个图标。请尝试双击此图标，它可以告诉您计算机从网络接
收到的无线信号的强度。

如要提高信号质量，请去掉干扰来源和／或将无线设备移动到距离无线接入点（无线路由器）比较近的地方。

我能够如何改善无线信号强度？

无线打印机无法在网络上通信的一个常见原因是无线信号质量很差。如果信号太弱、太失真或被物体阻挡，它
将不能在访问点和打印机之间传递信息。如需确定打印机是否从访问点接收到强信号，请打印网络设置
页。“质量”字段指出打印机正在接收的无线信号的相对强度。但是，可能会有间歇性的信号强度衰减，并且
虽然信号质量显示为高，但它可能在某些情况下衰减。

如果您认为访问点（无线路由器）和打印机之间的信号强度有问题，请尝试下列办法中的一个或多个：

注意：

• 下面的解决办法适用于 Infrastructure 网络。如果您使用 Ad hoc 网络，请在解决办法建议调整访问点时调
整计算机。

• Ad hoc 网络的范围比 Infrastructure 网络小得多。如果打印机和计算机之间的通信有问题，请尝试移动打
印机使之更靠近计算机。

移动打印机使之更靠近访问点

如果打印机离访问点太远，它将不能与网络上的其他设备通信。对于大多数室内无线网络，访问点和打印机
之间的最大距离大约为 100 英尺（30 米）。根据网络布局和访问点的限制，此距离可以更长或更短。

移除访问点和打印机之间的障碍物

来自访问点的无线信号将通过大多数物体。大部分墙壁、地板、家具和其他物体将不会阻碍无线信号。但
是，有些材料密度太大，无法让信号通过，如包含金属和混凝土的物体。布置打印机和访问点，使信号不会
被此类物体阻碍。

移除干扰源

其他类型的无线电频率可能会导致网络上的无线信号的问题，造成似乎来来回回的打印问题。

• 关闭可能的干扰来源。

• 当通过无线网络打印时，请避免使用微波炉、无绳电话（但除便携式电话）、婴儿监视器，几乎所有的
厨房设备，无线监视装置或含有电机的装置。

• 如果有另一个无线网络在附近运转，请更改访问点上的无线通道。

• 请勿将访问点放在打印机或其他电子设备上。此类设备也会干扰无线信号。
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布置网络以减少信号吸收

即使无线信号能够通过物体，它也会稍有减弱。如果它通过太多物体，它会显著减弱。当无线信号通过物体
时，所有物体都会吸收部分无线信号，并且某些类型的物体吸收足够多而导致通信问题。将访问点尽可能放
在室内高点，以避免信号吸收。

我如何确认我的计算机和打印机连接在同一个无线网络中？

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，打
印机的 SSID 必须与计算机的 SSID 一致。

Windows 用户

1 获取计算机所连接的网络的 SSID：

a 在您的网页浏览器的地址栏中输入您的接入点（无线路由器）的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”区域：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入您的用户名和密码。

c 单击“确定”。

d 在“无线设置”区域中查找 SSID。

e 记录下 SSID。

注意：请确认您准确地记录了所有的内容，包括大写字母。

2 获取打印机所连接的网络的 SSID：

a 从打印机打印一张网络设置页。

b 在“无线”区域中查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行无线设置应用程序，在计算机所使用的无线网络中安装打印机。

使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高的版本：

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录下 SSID。
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Mac OS X version 10.4 或更早的版本：

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录下 SSID。

使用接入点的 Macintosh（英文版）用户

1 在您的网页浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“无线设置”区域中查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥／WPA 密钥（如果显示的话）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥／WPA 密钥保存在安全的地方，以备将来使用。

我可以同时通过 USB 连接和网络连接使用我的打印机吗？

是，打印机支持同时使用 USB 连接和网络连接。打印机可以按照以下方法进行配置：

• 本地连接（使用 USB 电缆连接在计算机上）

• 无线网络

• 同时使用无线网络和本地连接

什么是 MAC 地址？

媒体访问控制(MAC)地址是与网络设备的硬件相关联的一个 48 位标识符。MAC 地址也称为物理地址，因为它
与设备的硬件有关，而与软件无关。MAC 地址使用十六进制数字显示，格式为：01-23-45-67-89-AB。

虽然可以改变网络设备的 MAC 地址，但是通常不这样做。因此，MAC 地址被认为是固定不变的。IP 地址很
容易改变，因此 MAC 地址是识别网络中特定设备的更可靠的方法。

带有安全功能的路由器可以过滤网络中的 MAC 地址。此功能可以只允许指定的设备访问网络，由它们的 MAC
地址识别，也可以阻止来自不必要的设备的访问。如果您的网络使用了 MAC 地址过滤，请确认将打印机的
MAC 地址添加到允许设备列表中。
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我如何查找 MAC 地址？

大多数网络设备都有一个唯一的硬件识别码，用于和网络中的其他设备区分开。这称为媒体访问控制(MAC)地
址。

当您在网络中安装打印机时，请确认您选择了带有正确 MAC 地址的打印机。

MAC 地址标签位于打印机的里面。

内部打印服务器的 MAC 地址是一系列字母和数字。其他设备有时使用一种称为统一管理地址(UAA)的 MAC
地址。

注意：您可以在接入点（路由器）上设置一个 MAC 地址列表，只允许 MAC 地址相符的设备使用网络。这称
为 MAC 过滤。如果您在您的接入点上启用了 MAC 过滤功能，并且希望将一台打印机添加到网络中，打印机
的 MAC 地址必须包含在 MAC 地址列表中。

什么是 IP 地址？

IP 地址是 IP 网络中的设备（例如无线打印机、计算机或无线接入点）所使用的一个唯一的号码，用于互相定
位和通讯。只有当 IP 网络中的设备有唯一且有效的 IP 地址时，设备之间才可以互相通讯。唯一的 IP 地址表
示在同一个网络中不会有两个设备有相同的 IP 地址。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.100.110。

什么是 TCP/IP？
网络可以正常工作是因为计算机、打印机和其他设备可以通过电缆或者使用无线信号互相发送数据。一组称为
协议的数据传输规则可以使这种数据传输成为可能。协议可以被看作是一种语言，并且和语言类似，它有一定
的规则以允许参与者互相通讯。

不同类型的网络使用不同的协议，但是传输控制协议/网际协议(TCP/IP)是最常用的。TCP/IP 用于在互联网和
大多数公司和家庭网络中发送数据。

由于计算机不能理解文字，只能依靠数字进行通讯，因此 TCP/IP 要求网络中所有使用 TCP/IP 进行通讯的设
备必须有一个 IP 地址。IP 地址实际上是数字格式的唯一的计算机名称，用于在网络中传输数据。IP 地址可以
允许 TCP/IP 确保网络中的各种设备正确请求和接收数据。
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我如何查找 IP 地址？

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中单击 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

查找打印机的 IP 地址

• 从打印机打印一张网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

1 在打印机操作面板上依次选择：

 > 网络设置 > TCP/IP

2 查找“IP地址”。

IP 地址是如何指定的？

IP 地址可能由网络使用动态主机分配协议(DHCP)自动指定。当打印机在计算机上安装完毕后，计算机将会把
所有的打印作业按照此地址通过网络发送到打印机。

如果 IP 地址没有自动指定，在无线设置过程中，当您从可用的列表中选择您的打印机之后会要求您手动输入
地址和其他的网络信息。

什么是密钥索引？

一个接入点（无线路由器）最多可以配置 4 个 WEP 密钥。但是，每一次在网络中只使用一个密钥。密钥带有
一个编号，密钥的编号就是密钥索引。当接入点上配置了多个 WEP 密钥时，无线网络中的所有设备都必须使
用相同的密钥索引。

在您的打印机上选择您在接入点上使用的同一个密钥索引。

网络

105



维护打印机

维护打印墨盒
除了以下您可以完成的任务以外，如果您的打印机连接在电源插座上，每周将会执行一次自动维护操作。打印
机将会暂时退出节约能源模式，或者临时打开电源（如果电源已关闭）。

查看墨水量

使用打印机操作面板

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“维护”，然后按  按钮。

3 再次按  按钮选择“墨水量”。

4 按箭头按钮查看每个打印墨盒的墨水量。

使用打印机软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击“打印机主页”。

4 从打印机下拉列表中选择您的打印机。

5 在“维护”选项卡中单击“查看墨水量”。

Macintosh（英文版）用户

1 在 Finder 桌面上双击打印机文件夹。

2 选择 Printer Utility。

3 在 Maintenance 选项卡中查看墨水量。

校正打印头

如果您打印的图像中的字符或线条出现锯齿状或波浪状，您可能需要校正打印头。

使用打印机操作面板

1 装入普通纸。

2 按打印机操作面板上的  按钮。

3 反复按箭头按钮选择“维护”，然后按  按钮。

维护打印机
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4 反复按箭头按钮选择“校正打印机”，然后按  按钮。

5 再次按  按钮。

打印机将会打印出一张校正测试页。

注意：请不要移开校正测试页，直到打印完成。

使用打印机软件

Windows 用户

1 装入普通纸。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 单击“打印机主页”。

5 从打印机下拉列表中选择您的打印机。

6 在“维护”选项卡中单击“校正打印墨盒”。

7 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 装入普通纸。

2 在 Finder 桌面上双击打印机文件夹。

3 选择 Printer Utility。

4 在 Maintenance 选项卡中单击 Print Alignment Page。

5 按照计算机屏幕上的指导进行操作。

如果您是为了提高打印质量而校正打印墨盒，请重新打印您的文档。如果打印质量没有提高，请清洗打印墨盒
喷头。

清洗打印头喷头

打印质量差有时候是由打印头喷头堵塞引起的。清洗打印头喷头可以提高您的打印质量。

注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量太低了，您必须先更换打印墨盒，然后才可以清洗打印头喷头。

使用打印机操作面板

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“维护”，然后按  按钮。
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3 反复按箭头按钮选择“清洗打印头”，然后按  按钮。

4 按  按钮清洗打印头喷头。

打印机将会打印出一张清洗测试页。

使用打印机软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击“打印机主页”。

4 从打印机下拉列表中选择您的打印机。

5 在“维护”选项卡中单击“清洗打印墨盒”。

Macintosh（英文版）用户

1 在 Finder 桌面上双击打印机文件夹。

2 选择 Printer Utility。

3 在 Maintenance 选项卡中单击 Clean Print Nozzles。

打印机将会打印出一张清洗测试页。

清洗打印机的外壳
1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗打印机的外壳时，为了避免电击危险，请在操作之前从电源插座上断开电源
线，并断开打印机上的所有电缆。

2 从打印机内取出所有的纸张。

3 用水将一块干净且不掉毛的软布润湿。

警告—可能的损坏：请不要使用普通家用的清洁剂或去污剂，因为它们可能会损坏打印机的表面涂层。

4 请只清洗打印机的外面，并确认擦掉出纸托盘上的墨迹。

警告—可能的损坏：使用湿布清洗打印机的内部可能会损坏您的打印机。

5 在开始新的打印作业之前，请确认打印机完全干燥。

擦洗扫描仪玻璃
1 用水将一块干净且不掉毛的软布润湿。

2 轻轻地擦洗扫描仪玻璃。

注意：在您将文档放置在扫描仪玻璃上之前，请确认文档上的墨水或修正液已经完全干燥。

维护打印机
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问题解答

在您解决问题之前
使用这些注意事项可以解决大多数打印机问题：

• 请确认电源线的一端连接在打印机上，另一端连接在正确接地的电源插座上。

• 请确认打印机没有连接在任何电涌保护器、不间断电源或延长线上。

• 请确认打印机的电源已打开。

• 请确认打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 检查打印机是否有错误信息，并解决错误。

• 检查是否有卡纸信息，并清除卡纸。

• 检查打印墨盒，如有必要，请安装新的打印墨盒。

• 使用服务中心查找并解决问题（仅限于 Windows）。

• 关闭打印机的电源，等待大约 10 秒钟，然后重新打开打印机。

使用服务中心解决打印机问题
服务中心为您提供了逐步的问题解答帮助，并包含有关打印机维护任务和客户支持的链接。

如要打开服务中心，您可以使用以下的方法：

方法 1： 方法 2：

如果错误信息对话框中包含“如要获取其他的帮
助，请使用服务中心”链接，请单击此链接。

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机
程序文件夹。

3 单击“打印机主页”。

4 在“支持”选项卡中单击“服务中心”。

如果问题解答没有解决您的问题
访问我们的国际互联网站 support.dell.com 查找以下内容：

• 在线技术支持

• 电话技术支持的联系号码

安装问题解答
• 第110 页“显示屏上的文字是错误的语言”

• 第110 页“打印头错误”

• 第112 页“软件不能安装”

• 第113 页“打印作业不打印或者缺页”

• 第114 页“打印机打印出空白页”

问题解答
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• 第114 页“打印机忙或者没有反应”

• 第114 页“无法从打印队列中删除文档”

• 第115 页“无法通过 USB 进行打印”

显示屏上的文字是错误的语言

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

使用打印机菜单改变语言

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“默认值”，然后按  按钮。

3 反复按箭头按钮选择“设置默认值”，然后按  按钮。

4 反复按箭头按钮选择“使用出厂设置”，然后按  按钮。

5 完成初始打印机设置。

使用按钮组合改变语言（如果您看不懂当前的语言）

1 关闭打印机的电源。

注意：如果您在“设置”菜单中设置了节约能源时限，请按住  按钮 3 秒钟关闭打印机的电源。

2 同时按住  和  按钮，然后按  按钮打开打印机的电源。

注意：请不要放开  和  按钮，直到显示屏上出现“选择语言”，表示打印机已经恢复完毕。

3 完成初始打印机设置。

打印头错误

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的方法：

取出并重新安装打印头

1 抬起扫描仪部件并打开保护盖。
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110



2 取出打印头。

警告—可能的损坏：请不要触摸打印头墨水过滤器或打印头喷头。

3 使用一块干净且不掉毛的布擦洗触点。

• 打印头上

• 打印头拖车上

警告—可能的损坏：请不要触摸打印头墨水过滤器或打印头喷头。
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4 重新装入打印头，然后关闭保护盖，直到固定住。

5 关闭打印机。

注意：如果取出并重新安装打印头不能解决错误，请联系用户支持。

软件不能安装

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试反安装并重新安装软件。

在您重新安装软件之前，请完成以下操作：

请确认您的计算机满足打印机包装箱上列出的最小系统需求

在安装软件之前暂时关闭 WINDOWS 安全程序

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。
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重新连接打印机电源

1 关闭打印机的电源，然后从电源插座上断开电源线。

2 从打印机上轻轻地取下电源线，然后重新连接在打印机上。

3 将电源线重新连接在电源插座上，然后打开打印机的电源。

打印作业不打印或者缺页

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印墨盒安装正确

1 打开打印机的电源，然后抬起扫描仪部件。

2 请确认打印墨盒安装正确。

打印墨盒应该牢固地固定在打印头上相应颜色的槽中。

3 关闭扫描仪部件。

在您发送打印作业之前，请在“打印”对话框中选择您的打印机

请确认打印作业没有被暂停

请确认您的打印机被设置为默认打印机

重新连接打印机电源

1 关闭打印机的电源，然后从电源插座上断开电源线。

2 从打印机上轻轻地取下电源线，然后重新连接在打印机上。

3 将电源线重新连接在电源插座上，然后打开打印机的电源。

断开并重新连接您的打印机上的 USB 电缆

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

反安装并重新安装打印机软件

问题解答
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打印机打印出空白页

空白页可能是由不正确地安装打印墨盒所引起的。

重新安装打印墨盒并深度清洗和校正打印头

1 重新安装打印墨盒。请参阅第 13 页“更换打印墨盒”获取更多的信息。

如果打印墨盒看起来不太合适，请确认打印头安装正确，然后重新尝试安装打印墨盒。

2 装入普通纸。

3 按打印机操作面板上的  按钮。

4 反复按箭头按钮选择“维护”，然后按  按钮。

5 反复按箭头按钮选择“深度清洗打印头”，然后按  按钮。

打印机将会打印出一张清洗测试页。

6 反复按箭头按钮选择“校正打印机”，然后按  按钮。

打印机将会打印出一张校正测试页。

注意：

• 请不要移开校正测试页，直到打印完成。

• 请不要连续进行深度清洗。如果深度清洗之后问题仍然没有解决，请联系技术支持。

打印机忙或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印机没有处于节约能源模式

如果电源指示灯缓慢闪烁，说明打印机处于节约能源模式。请按  按钮启动打印机。

如果打印机没有退出节约能源模式，请重新启动电源：

1 从电源插座上断开电源线，然后等待 10 秒钟。

2 将电源线重新连接在电源插座上，然后打开打印机的电源。

如果此问题仍然存在，请访问我们的网站，尝试升级您的打印机软件或固件。

重新连接打印机电源

1 关闭打印机的电源，然后从电源插座上断开电源线。

2 从打印机上轻轻地取下电源线，然后重新连接在打印机上。

3 将电源线重新连接在电源插座上，然后打开打印机的电源。

无法从打印队列中删除文档

如果您的作业滞留在打印队列中无法删除，导致其他的作业不能打印，计算机和打印机可能无法进行通讯。

重新启动计算机并重新尝试

问题解答
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无法通过 USB 进行打印

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

请确认 WINDOWS 中的 USB 端口已启用

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按 Enter 键，或者单击“确定”。

设备管理器将会出现。

4 单击“通用串行总线控制器”旁边的加号(+)。

如果您看到 USB Host Controller 和 USB Root Hub 列在其中，说明 USB 端口已经启用。

请参阅计算机的相关文档获取更多的信息。

反安装并重新安装打印机软件

卡纸和进纸错误问题解答
• 第115 页“打印机内发生卡纸”

• 第116 页“纸张支架内发生卡纸”

• 第116 页“自动文档传送器(ADF)内发生卡纸（仅限于某些型号）”

• 第117 页“纸张或特殊介质进纸错误”

打印机内发生卡纸

注意：打印机内部的部件非常敏感。当清除卡纸时请避免不必要地触摸这些部件。

问题解答

115



1 按  按钮关闭打印机。

2 检查进纸匣，或者抬起扫描仪部件检查卡纸。

3 牢固地抓住纸张，然后轻轻地拉出。

注意：拉出纸张时请小心不要撕破纸张。

4 按  按钮重新打开打印机。

纸张支架内发生卡纸

注意：打印机内部的部件非常敏感。当清除卡纸时请避免不必要地触摸这些部件。

1 按  按钮关闭打印机。

2 牢固地抓住纸张，然后轻轻地拉出。

注意：拉出纸张时请小心不要撕破纸张。

3 按  按钮重新打开打印机。

自动文档传送器(ADF)内发生卡纸（仅限于某些型号）

注意：打印机内部的部件非常敏感。当清除卡纸时请避免不必要地触摸这些部件。

问题解答
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1 打开 ADF 盖板，然后轻轻地拉出卡住的纸张。

注意：拉出纸张时请小心不要撕破纸张。

2 关闭 ADF 盖板。

3 触摸“DONE（完成）”或者按  按钮，取决于您的打印机型号。

4 在您的计算机上继续打印作业。

纸张或特殊介质进纸错误

如果纸张或特殊介质进纸不正常、扭曲、同时进多页纸或者粘在一起，以下是可能的解决方法。请尝试其中的
一种或多种方法：

检查纸张条件

请只使用新的且没有皱褶的纸张。

检查纸张装入
• 请在打印机内装入较少数量的纸张。

• 装入纸张时请确认可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指导。）

• 请参阅针对您的纸张和特殊介质的详细装纸指导。

随时移开打印机送出的打印页

调节进纸导轨以适合装入的纸张

问题解答
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打印问题解答
• 第118 页“打印页边缘处的打印质量非常差”

• 第119 页“打印的图像中出现条纹或线条”

• 第119 页“打印速度慢”

• 第120 页“当打印时计算机速度变慢”

打印页边缘处的打印质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查最小打印设置

除非您使用无边界功能，否则请使用以下的最小打印边距设置：

• 左边距和右边距：

– 6.35Letter 尺寸的纸张：6.35 毫米（0.25 英寸）

– 3.37 除 Letter 以外的所有其他纸张：3.37 毫米（0.133 英寸）

• 上边距：1.7 毫米（0.067 英寸）

• 下边距：12.7 毫米（0.5 英寸）

选择无边界打印功能

Windows 用户

1 打开文档或照片，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 在“打印设置”选项卡的“纸张选项”区域中选中“无边界”。

Macintosh（英文版）用户

1 打开照片，从应用程序中单击 File > Page Setup。

如果 File 菜单中没有 Page Setup 项目，请转到步骤 2。否则请指定您的打印设置：

a 从 Settings 弹出菜单中选择 Page Attributes。

b 从 Format for 弹出菜单中选择您的打印机。

c 从 Paper Size 弹出菜单中选择名称中带有“(Borderless)”的纸张尺寸。

例如，如果您装入了 4 x 6 照片卡，请选择 US 4 x 6 in (Borderless)。

d 选择打印方向，然后单击 OK。

2 从菜单栏中单击 File > Print。

如果您已经在步骤 1 中指定了打印机、纸张尺寸和打印方向，在您转到步骤 3 之前，您可能必须从 Printer
弹出菜单中重新选择您的打印机。否则请设置这些内容：

a 从 Printer 弹出菜单中选择您的打印机。

b 从 Paper Size 弹出菜单中选择名称中带有“(Borderless)”的纸张尺寸。

例如，如果您装入了 4 x 6 照片卡，请选择 US 4 x 6 in (Borderless)。

c 选择打印方向。

问题解答

118



3 如有必要，请单击 Advanced。

4 从打印选项弹出菜单中选择 Print Settings 或 Quality & Media。

• 从 Paper Type 弹出菜单中选择纸张类型。

• 从 Print Quality 弹出菜单中选择 Photo 或 Best。

5 单击 Print。

打印的图像中出现条纹或线条

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

查看墨水量

更换墨水量偏低或空的打印墨盒。

在打印机软件中选择较高的打印质量

请确认打印墨盒安装正确

校正打印头

清洗或深度清洗打印头喷头

注意：如果这些方法不能去除打印的图像中的条纹或线条，请联系技术支持。

打印速度慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

提高计算机处理速度
• 请关闭所有不用的应用程序。

• 尽量减小文档中照片和图像的数量和尺寸。

• 尽量从您的系统中去除不用的字体。

增加内存

考虑为您的计算机购买更多的内存(RAM)。

在打印机软件中选择较低的打印质量

手动选择您使用的纸张类型

反安装并重新安装打印机软件

问题解答
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当打印时计算机速度变慢

以下是可能的解决方法。请尝试其中的一种：

如果您使用 USB 连接，请尝试更换另一根 USB 电缆

如果您在网络中，请重新启动接入点（路由器）的电源

1 从接入点上断开电源线。

2 等待 10 秒钟，然后重新连接电源线。

复印和扫描问题解答
• 第120 页“打印机不能复印或扫描或者没有反应”

• 第120 页“扫描仪部分没有关闭”

• 第120 页“复印或扫描的质量非常差”

• 第121 页“文档或照片只复印或扫描了一部分”

• 第121 页“扫描不成功”

• 第121 页“扫描任务花费很长的时间或者导致死机”

• 第122 页“无法通过网络扫描至计算机”

打印机不能复印或扫描或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

将您的打印机设置为默认打印机

反安装并重新安装打印机软件

扫描仪部分没有关闭

1 抬起扫描仪部分。

2 取出所有导致扫描仪部分打开的堵塞物。

3 关闭扫描仪部分。

复印或扫描的质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

擦洗扫描仪玻璃

在打印机软件中调整扫描质量

问题解答
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浏览有关复印和扫描的提示以提高打印质量

使用更清晰的文档或图像原件

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于正确的角落

文档或照片只复印或扫描了一部分

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于正确的角落

在打印机软件中选择您装入的纸张尺寸

请确认“原件尺寸”设置与您要扫描的文档尺寸一致

扫描不成功

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

重新启动计算机

扫描任务花费很长的时间或者导致死机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

关闭其他不用的应用程序

使用较低的扫描分辨率

问题解答
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无法通过网络扫描至计算机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印机和目的地计算机连接在同一个网络中

请确认在目的地计算机上安装了打印机软件

传真问题解答
• 第122 页“传真问题解答注意事项”

• 第123 页“无法发送传真”

• 第125 页“无法接收传真”

• 第126 页“无法运行传真软件”

• 第126 页“打印机操作面板上的传真错误信息”

有关常用术语和任务的详细说明，请参阅：

• 第 62 页“设置打印机进行传真”

• 第 79 页“传真常见问答”

传真问题解答注意事项

在您解决问题之前，使用以下的注意事项可以解决大多数传真问题：

• 检查拨号音可以确认电缆连接正确并且电话线可用。

如要检查拨号音：

1 将一部模拟电话机连接在墙壁电话线插座上。

2 通过电话听筒收听拨号音。

如果您听到了拨号音，说明连接正确，并且线路可以使用。

如果您没有听到拨号音，请检查注意事项中的其他项目，检查每一项之后再次收听拨号音。

• 请确认您按照“安装打印机进行传真”一章中的安装方法正确地安装了设备。

• 请确认电缆连接在正确的插口上。

• 请确认电缆连接牢固。

请检查以下硬件（如果使用）的电缆连接：

– 电源适配器

– 电话机

– 电话答录机

– VoIP 适配器

– DSL 过滤器

– 分线器

– 电缆调制解调器

问题解答
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• 如果打印机连接在数字用户线路(DSL)上，请为打印机安装一个 DSL 过滤器。DSL 过滤器可以使线路上的
传真信号和互联网信号之间的干扰最小。将打印机连接在 DSL 过滤器的电话插口上，将计算机连接在过滤
器的 DSL/HPN 插口上。

如要确认您正确地将打印机连接在过滤器上，请将一部模拟电话机连接在打印机后面的  插口上，然后
收听拨号音。

• 如果打印机连接在 VoIP 线路上，请确认打印机连接在可用的电话插口上。将打印机连接在 VoIP 适配器的
第一个插口上，通常标有“电话插口”或“电话线 1”。

如要确认电话插口可以使用，请将一部模拟电话机连接在插口上，然后收听拨号音。

• 如果您使用了分线器，请确认您使用的是电话分线器。请不要使用线路分线器。如要确认您使用的是正确
的分线器，请将一部模拟电话机连接在分线器上，然后收听拨号音。

• 如果您已经检查了这些注意事项，但是仍然没有听到拨号音，请与您的线路供应商联系。

无法发送传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认您在打印机上注册了您的使用者信息

如果您在初始设置过程中没有输入您的使用者信息，请输入您的传真名称和传真号码。在一些国家／地区
中，不输入您的传真名称或公司名称您将不能发送传真。一些传真机还会阻止未知的传真或没有发件人信息
的传真。

降低传真调制解调器的传输速度

打印机的调制解调器传输数据的速度可以达到 33,600 bps。这是打印机可以发送和接收传真的最大速度。
但是，您不需要将调制解调器设置为最快的传输速度。接收传真机的调制解调器的速度必须等于或大于您发
送传真的速度。否则，接收方将不能接收您的传真。

如要降低调制解调器的传输速度：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 反复按箭头按钮选择“最大发送速度”，然后按  按钮。

5 选择发送速度，然后按  按钮。

设置打印机在拨号之前扫描文档原件

如果您设置打印机在拨号之后扫描文档原件，打印机不会自动重拨。

请设置打印机在拨号之前扫描，当传真失败时您不必重新扫描文档。扫描的文档保存在打印机内存中。打印
机可以读取出来，然后自动重拨号码。

如要设置打印机在拨号之前扫描：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。
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4 反复按箭头按钮选择“扫描”，然后按  按钮。

5 反复按箭头按钮选择“在拨号之前”，然后按  按钮。

启用错误修正

如果线路上有太多的噪音，传真的文档中可能会出现错误和污点。此选项可以让打印机重新发送损坏的数据
块并修正错误。当传真中的错误太多时，接收传真机可能会拒收此传真。

如要确认错误修正已启用：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 反复按箭头按钮选择“错误修正”，然后按  按钮。

5 检查“错误修正”是否设置为“开”。

如果没有设置为“开”，请反复按箭头按钮选择“开”，然后按  按钮。

启用自动传真转换

如果接收传真机不支持彩色传真，此选项可以自动将发送的彩色传真转换为黑白传真。此选项也可以自动将
传真的分辨率降低为接收传真机可以支持的分辨率。

如要确认自动传真转换已启用：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 反复按箭头按钮选择“自动传真转换”，然后按  按钮。

5 检查“自动传真转换”是否设置为“开”。

如果没有设置为“开”，请反复按箭头按钮选择“开”，然后按  按钮。

请确认“拨号前缀”设置正确

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果
打印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。

请确认您在打印机上输入的拨号前缀是适用于您的网络的正确前缀。

如要检查“拨号前缀”设置：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“拨号和发送”，然后按  按钮。

4 反复按箭头按钮选择“拨号前缀”，然后按  按钮。

5 按箭头按钮创建或编辑前缀。

6 如果前缀不正确，请输入正确的前缀，然后按  按钮。
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无法接收传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认您已经为您的安装方法配置了正确的设置

传真设置取决于打印机连接在自己的传真线上还是和其他设备共用线路。

如果打印机和电话答录机共用电话线，请确认设置了以下内容：

•“自动应答”设置为“开”。

• 和电话答录机相比，打印机在较多数目的铃响之后应答来电。

• 打印机在正确的特色铃声时应答来电（如果您申请了特色铃声服务）。

如果打印机和申请了语音邮件功能的电话机共用电话线，请确认设置了以下内容：

•“自动应答”设置为“关”（如果您在电话线上只有一个号码）。

• 打印机在正确的特色铃声时应答来电（如果您申请了特色铃声服务）。

请确认打印机连接在模拟插口上

打印机是一种模拟设备。如果您使用专用分组交换机(PBX)系统，请确认打印机连接在 PBX 的模拟插口
上。您可能需要一个可以将数字信号转换成模拟信号的数字线路转换器。

请确认打印机的内存没有满

打印机在打印接收到的传真之前会将传真保存在打印机内存中。如果打印机在接收传真时墨水用完了或者纸
张用完了，打印机可以保存传真，以便您以后再打印。但是，如果打印机的内存满了，打印机可能无法接收
更多的传真。当打印机的内存已满时，显示屏上将会出现错误信息。请解决错误以释放打印机内存空间。

请确认“传真转发”已禁用

您可能启用了“传真转发”。禁用此选项可以让打印机接收传真。

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

4 反复按箭头按钮选择“传真转发”，然后按  按钮。

5 反复按箭头按钮选择“关”，然后按  按钮。

增大铃声音量

如果您设置打印机手动接收传真（自动应答关），请增大铃声音量。

请确认您有正确的手动应答码

如果您设置打印机手动接收传真（自动应答关），当有传真来电时，您需要按正确的代码以便打印机可以接
收传真。
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如要获取正确的代码：

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“传真设置”，然后按  按钮。

3 反复按箭头按钮选择“铃声和应答”，然后按  按钮。

4 反复按箭头按钮选择“手动应答码”，然后按  按钮。

5 记录下显示屏上显示的手动应答码。

无法运行传真软件

打印机必须连接在电话线、DSL 或 VoIP 线上，然后您才可以在传真软件中配置传真设置。

请确认传真软件已安装

对于 Windows 用户来说，传真解决方案软件是可选的，只有当您在安装过程中的“安装其他的软件”界面
中选择了此软件时才会和打印机软件一起安装。如果您没有安装传真软件，“打印机主页”中的“传真”选
项卡将会提示您访问我们的网站，您可以下载此软件。

请确认打印机连接在电话线上

您需要将打印机连接在您的电话线上（通过标准墙壁电话线插座、DSL 过滤器或 VoIP 适配器），然后您才
可以打开传真软件并配置传真设置。

请确认打印机连接在计算机上

请确认打印机没有处于节约能源模式

打印机操作面板上的传真错误信息

错误信息： 问题： 可能的解决方法：

远程传真错误 接收传真机无法接收传真。接收方
的错误可能由多个因素引起。

• 重新发送传真。可能是连接的质量出现
了问题。

• 降低您的传真调制解调器的传输速度。

• 注册您的使用者信息。在一些国家／地
区中，不注册您的传真名称和传真号码
您将不能发送传真。一些传真机还会阻
止没有发件人信息的传真。

不支持的传真模式 接收传真机不支持彩色传真或者您
要发送的文档的扫描分辨率。

• 启用自动传真转换。打印机可以自动将
彩色传真转换为黑白传真，并较低文档
的扫描分辨率。

• 降低传真质量。

• 在 Letter 尺寸的纸张上重新定制您的文
档。
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错误信息： 问题： 可能的解决方法：

不支持的压缩 接收传真机的传真调制解调器不支
持数据压缩。传真调制解调器压缩
数据可以加快传输速度，但是接收
传真调制解调器需要有相同的压缩
编码。

• 降低传真调制解调器的传输速度，然后
重新发送传真。

• 启用自动传真转换。

不支持的分辨率 接收传真机不支持您要发送的文档
的扫描分辨率。

• 降低传真质量。

• 启用自动传真转换。

不可恢复的传真错误 传真调制解调器出现严重的错误。 关闭打印机的电源，然后重新打开并重新
发送传真。

传真调制解调器错误 打印机的传真调制解调器可能正
忙，或者传真调制解调器可能在传
输过程中出现了问题。

关闭打印机的电源，然后重新打开并重新
发送传真。

电话线连接在机器后面错误的插座
上

电话线被连接在打印机后面错误的
插口上。

将电话线连接在打印机后面的  插口上。

检测到数字线路 打印机连接在数字线路上。 打印机是一种模拟设备，必须连接在模拟
线路上。如要将打印机连接在数字线路
上，您必须使用数字线路转换器或过滤器。

请参阅“安装打印机进行传真”一章获取
更多的信息。

连接失败

电话线路错误

电话线没有连接

打印机无法检测到拨号音。 请参阅“传真问题解答注意事项”。

电话线路忙 您的电话线路或者接收传真机的电
话线路正忙。如果打印机和其他设
备（电话机、电话答录机）共用线
路，这种情况特别容易发生。

• 设置打印机重拨。

• 增加重拨尝试之间的时间间隔。

• 尝试拨打您希望发送传真的电话号码，
确认对方工作正常。

• 如果电话线路正被其他的设备占用着，
请等待其他的设备完成操作，然后再尝
试发送传真。

• 在稍后的时间定时重新发送传真。

• 设置打印机在拨号之前扫描。扫描的文
档保存在打印机内存中。打印机可以读
取出来，然后自动重拨号码。

无应答 接收传真机可能禁用了“自动应
答”。

• 检查号码，然后重新发送传真。

• 设置打印机重拨。

注意：根据您所在的国家或地区，重拨
尝试次数可能会受到限制，您在您的打
印机上设置的重拨设置将不起作用。

• 在稍后的时间定时重新发送传真。

没有来电号码

来电已中断

由于传真来电没有发件人信息，您
的打印机中断了来电。您可能选择
了阻止没有来电号码的传真，或者
您所在的国家或地区不允许接收没
有来电号码的传真。

禁用“阻止无号码”。
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如要解决传真软件中的错误信息，请单击“帮助”浏览传真软件的帮助信息。

存储卡问题解答
• 第128 页“存储卡问题解答注意事项”

• 第128 页“插入存储卡后没有任何反应”

• 第128 页“无法从存储卡或闪存驱动器中进行打印”

• 第129 页“无法通过无线网络从存储卡传送照片”

存储卡问题解答注意事项

在您解决问题之前，使用以下的注意事项可以解决大多数存储卡问题：

• 请确认您使用的存储卡是打印机所支持的类型。

• 请确认存储卡没有损坏。

• 请确认存储卡中包含支持的文件类型。

插入存储卡后没有任何反应

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

重新插入存储卡

存储卡可能插入太慢。请取出并快速地重新插入存储卡。

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

检查网络连接

如果打印机和计算机都连接在网络中，请确认正确的主机和设备正在通讯。请在计算机上选择打印机或者在
打印机上选择计算机。

无法从存储卡或闪存驱动器中进行打印

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。
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3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

检查网络连接

如果打印机和计算机都连接在网络中，请确认正确的主机和设备正在通讯。请在计算机上选择打印机或者在
打印机上选择计算机。

无法通过无线网络从存储卡传送照片

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认打印机和目的地计算机的电源都已打开，并且准备就绪

从打印机上的列表中选择正确的计算机名

请确认您的无线网络已连接并且可以使用

如果您的无线连接不可用，请使用 USB 电缆连接您的打印机和计算机。

无线问题解答
• 第130 页“无线问题解答注意事项”

• 第130 页“将无线设置恢复为出厂默认设置”

• 第131 页“无法通过无线网络进行打印”

• 第134 页““继续”按钮无法使用”

• 第135 页“无法打印并且计算机上安装了防火墙”

• 第135 页“Wi-Fi 指示灯不亮”

• 第135 页“Wi-Fi 指示灯是绿色的，但是打印机不打印（仅限于 Windows）”

• 第137 页“Wi-Fi 指示灯是橙色的”

• 第138 页“在安装过程中，Wi-Fi 指示灯闪烁橙色”

• 第142 页“没有安装无线打印服务器”

• 第142 页“当进行无线打印时出现“无法通讯”信息”

• 第144 页“当连接到虚拟个人网络(VPN)时与打印机的通讯中断了”

• 第144 页“解决间歇无线通讯问题”
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无线问题解答注意事项

在开始无线打印机的问题解答之前，请确认以下事项：

• 打印机、计算机和无线接入点都接通电源，并且电源已打开。

• 无线网络可以正常工作。

尝试访问您的无线网络中的其他计算机。

如果您的网络可以访问 Internet，请尝试通过无线连接到 Internet。

• 您的 SSID 是正确的。

打印一张网络设置页并检查打印机所使用的 SSID。

如果您不确定您的 SSID 是否正确，请重新进行无线设置。

• 您的 WEP 密钥或 WPA 密钥是正确的（如果您的网络是安全加密的）。

登录无线接入点（无线路由器）并检查安全设置。

安全密钥类似于密码。同一个无线网络中的所有设备（使用 WEP、WPA 或 WPA2）必须共用一个相同的
安全密钥。

如果您不确定您的安全信息是否正确，请重新进行无线设置。

• 打印机和计算机位于无线网络范围内。

对于大多数网络来说，打印机和计算机应该位于距离无线接入点（无线路由器）100 英尺（30 米）以内的
地方。

• Wi-Fi 指示灯亮着并且是绿色的。

• 在您要使用打印机的计算机上安装了打印机驱动程序。

• 您选择了正确的打印机端口。

• 计算机和打印机连接在同一个无线网络中。

• 打印机远离可能干扰无线信号的障碍物或电子设备。

请确认打印机和无线接入点之间没有包含金属或混凝土的杆棒、墙壁或支柱。

很多设备可以干扰无线信号，包括婴儿监视器、发动机、无线电话、安全系统照相机、其他的无线网络和
一些蓝牙设备。

将无线设置恢复为出厂默认设置

1 按打印机操作面板上的  按钮。

2 反复按箭头按钮选择“网络设置”，然后按  按钮。

3 反复按箭头按钮选择“恢复网络适配器默认设置”，然后按  按钮。

4 反复按箭头按钮选择“是”，然后按  按钮。

打印机无线设置被恢复为出厂默认设置。您可以打印一张网络设置页进行确认。
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无法通过无线网络进行打印

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试反安装并重新安装软件。

在您重新安装软件之前，请先检查问题解答注意事项，然后尝试以下的方法：

关闭并重新打开接入点（无线路由器）

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接并解决连接问题。

从虚拟个人网络(VPN)上断开连接

当您通过 VPN 连接在其他网络中时，您将不能在您的无线网络中使用打印机。请结束您的 VPN，然后重新
尝试打印。

请确认“演示模式”已禁用

当“演示模式”启用时，一些打印机功能将无法使用。

在打印机操作面板上依次选择：

 > 演示模式 > 关 > 保存设置

检查您的 WEP 密钥或 WPA 密钥

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WEP 密钥中的 ASCII
字符需要区分大小写。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的 ASCII 字
符需要区分大小写。

注意：如果您不知道此信息，请参阅随同无线网络一起提供的帮助文档，或者与安装您的无线网络的人员联
系。

检查您的接入点上是否有关联／注册按钮

在欧洲、中东和非洲，当您向您的无线网络中添加打印机时，无线宽带 box（例如 LiveBox、AliceBox、
N9UF Box、FreeBox 或 Club Internet）可能会要求您按关联／注册按钮。

如果您使用这些 box 并需要更多的信息，请参阅随同您的 box 一起提供的帮助文档，或者与您的 Internet
服务供应商(ISP)联系。

移动您的无线接入点，使之远离其他电子设备

一些电子设备（例如微波或其他用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干扰。
请确认您的接入点没有放置在距离这些设备很近的地方。
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将计算机和／或打印机移动到距离接入点比较近的地方

您的无线网络的范围取决于很多因素，包括您的接入点和网络适配器的能力。如果您在打印时遇到问题，请
尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

检查无线信号质量

打印网络设置页并检查信号质量。如果列出的信号质量是好或者很好，说明导致此问题的是其他因素。

检查您的高级安全设置
• 如果您要使用 MAC（媒体访问控制）地址过滤功能来限制其他人对您的无线网络的访问，您必须将打印
机的 MAC 地址添加到可以连接到接入点的地址列表中。

• 如果您要设置接入点只分配有限数量的 IP 地址，您必须先改变此设置，然后才能添加打印机。

注意：如果您不了解如何进行这些改变，请参阅随同接入点一起提供的帮助文档，或者与安装您的无线网络
的人员联系。

请确认您的计算机连接在您的接入点上
• 打开您的网页浏览器并访问任意网站，确定您是否可以访问 Internet。

• 如果您的无线网络中有其他的计算机或资源，请检查并确认您是否可以从您的计算机上访问它们。

请确认您的计算机和打印机连接在同一个无线网络中

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，
打印机的 SSID 必须与计算机的 SSID 一致。

Windows 用户

1 获取计算机所连接的网络的 SSID。

a 在您的网页浏览器的地址栏中输入您的接入点的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”区域：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入接入点的用户名和密码。

c 单击“确定”。

d 在“无线设置”区域中查找 SSID。

e 记录下 SSID。

注意：请确认您准确地记录了所有的内容，包括大写字母。

2 获取打印机所连接的网络的 SSID：

a 从打印机打印一张网络设置页。

b 在“无线”区域中查找 SSID。
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3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行无线设置应用程序，在计算机所使用的无线网络中安装打印机。

使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高的版本

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录下 SSID。

Mac OS X version 10.4

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录下 SSID。

使用接入点的 Macintosh（英文版）用户

1 在您的网页浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“无线设置”区域中查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥／WPA 密钥（如果显示的话）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥／WPA 密钥保存在安全的地方，以备将来使用。

请确认您的操作系统适用于通过 AIRPORT 的无线打印（仅限于 MACINTOSH 英文
版）

打印机只支持在 Mac OS X version 10.5 或更高版本（英文版）中通过 AirPort 基站进行无线打印。
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“继续”按钮无法使用

请按顺序尝试以下的解决方法，直到“继续”按钮变为可用并且可以单击：

检查 USB 电缆是否牢固地连接在计算机和打印机的 USB 接口上

USB 接口旁边标记有  符号。

请确认打印机接通电源，并且电源已打开

检查  按钮指示灯是否亮着。如果您刚刚打开打印机，您可能需要断开并重新连接 USB 电缆。

请确认计算机上的 USB 接口可以使用

通过连接其他的设备测试 USB 接口。如果您可以在接口上成功地使用其他的设备，说明接口可以使用。

如果计算机上的 USB 接口不能使用，请尝试使用计算机上其他的 USB 接口。

请确认 USB 电缆可以使用

尝试使用不同的 USB 电缆。如果您使用的电缆的长度超过了 10 英尺，请尝试使用较短的电缆。

请确认您使用的是适用于您的打印机型号的正确光盘

比较光盘上的打印机型号和打印机上的型号。数字应该完全相同或者属于相同的系列。

如果您有任何疑问，请从我们的网站上下载最新版本的打印机软件。如要获取更多的信息，请参阅用户手册
中的“安装打印机软件”一章。您可以使用位于安装界面底部的链接浏览用户手册。

重新连接电源

1 关闭打印机的电源。

2 从电源插座上断开电源线。

3 从打印机的后面取下电源适配器，然后重新插入。

4 将电源线重新连接在电源插座上。

5 重新打开打印机的电源，然后在您的计算机上继续安装。

尝试重新运行安装程序

1 关闭安装程序。

2 取出光盘，然后重新启动计算机。

3 插入光盘，然后重新运行安装程序。

注意：

• 当您进入到“已安装的软件”界面时，请确认您选择了“安装打印机”。

• 当您进入到“设置新的打印机吗？”界面时，如果您已经安装了您的打印机，请选择“其他的计算
机”跳过硬件安装向导。
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检查您的计算机是否能够识别 USB 接口上的 USB 活动

打开设备管理器，检查当 USB 接口上连接了 USB 设备时设备管理器是否有动作：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按 Enter 键，或者单击“确定”。

设备管理器将会出现。

4 在 USB 接口上连接 USB 电缆或其他的设备，同时观察设备管理器窗口。当设备管理器识别出 USB 连
接时，窗口将会刷新。

• 如果设备管理器有动作，但是以上方法都不能解决问题，请拨打客户技术支持电话。

• 如果设备管理器没有动作，可能是您的计算机和它的 USB 支持有问题。如要进行安装，计算机必须
能够识别 USB 连接。

无法打印并且计算机上安装了防火墙

第三方（非 Microsoft）的防火墙可能会干扰无线打印。如果打印机和计算机都配置正确，并且无线网络可以
正常工作，但是打印机不能进行无线打印，可能是防火墙的问题。如果计算机上安装了防火墙（除 Windows
防火墙以外），请尝试以下的一种或多种方法：

• 使用制造商提供的最新的升级包升级防火墙。请参阅随同您的防火墙一起提供的帮助文档了解如何操作。

• 当您安装打印机或者尝试打印时，如果程序向防火墙请求访问，请确认您允许这些程序运行。

• 临时禁用防火墙，然后在计算机上安装无线打印机。当您完成无线安装后，重新启用防火墙。

Wi-Fi 指示灯不亮

检查电源

如果 Wi-Fi 指示灯不亮，请确认  指示灯亮着。如果  指示灯不亮，请检查以下内容：

• 请确认打印机接通电源，并且电源已打开。

• 请确认打印机连接在一个可用的插座上。

• 如果打印机连接在电源插线板上，请确认插线板已打开，并且可以正常工作。

Wi-Fi 指示灯是绿色的，但是打印机不打印（仅限于 Windows）
如果您已经完成了无线打印配置，并且所有的设置都是正确的，但是打印机不打印，请尝试以下的一种或多种
方法：

等待无线安装完成

请不要尝试打印、取出安装光盘、或者断开安装电缆，直到您看到“无线设置成功”界面。
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启用打印机

请确认打印机已启用：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击新的打印机图标，从弹出菜单中单击“使用联机打印机”。

5 关闭“打印机”或“打印机和传真”窗口，然后重新尝试打印。

选择无线打印机

您可能需要在您的计算机上选择无线打印机才可以无线使用打印机。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击带有匹配的名称和型号，并且后面带有“（网络）”字样的打印机图标。

5 从弹出菜单中单击“使用联机打印机”。

6 关闭“打印机”或“打印机和传真”窗口，然后重新尝试打印。

选择无线端口

如果您以前按照本地连接的打印机安装了您的打印机，您可能需要选择无线打印机才可以无线使用打印机。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 找到当前的端口。当前的端口前面有一个选中标记。

7 如果当前端口的“描述”区域中表明它是一个 USB 端口，请从列表中选择“描述”区域是“打印机端
口”的端口。请检查“打印机”区域中的打印机型号，确认您选择了正确的打印机端口。

8 单击“确定”，然后重新尝试打印。

问题解答

136



Wi-Fi 指示灯是橙色的

当 Wi-Fi 指示灯为橙色时，可能表示打印机：

• 没有在 Infrastructure 模式下进行配置

• 正在等待与其他的无线设备建立 Ad hoc 连接

• 没有连接在无线网络中

打印机可能因为干扰或者距离无线接入点（无线路由器）太远而无法加入网络，或者需要改变打印机设置。

以下是可能的解决方法。请尝试其中的一种或多种方法：

检查网络名称

请确认您的网络没有使用和您附近的其他网络相同的名称。例如，如果您和您的邻居都使用制造商默认的网
络名称，您的打印机可能会连接到您的邻居的网络中。

如果您没有使用唯一的网络名称，请参阅您的无线接入点（无线路由器）的帮助文档了解如何设置网络名
称。

如果您设置了新的网络名称，您必须将打印机和计算机的 SSID 重新设置为同一个网络名称。

检查安全密钥

如果您使用 WEP 安全性

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。

如果您使用 WPA 安全性

有效的 WPA 密钥应该为：

• 8–63 个 ASCII 字符。WPA 密钥中的 ASCII 字符需要区分大小写。

或者

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。我们不推荐您使用这样的无线网络，因为它可
以允许入侵者未经过您的许可使用您的网络资源。

将计算机和／或打印机移动到距离无线接入点（无线路由器）比较近的地方

802.11b 或 802.11g 网络中的设备之间的距离可以达到 300 英尺，而 802.11n 网络的无线网络范围可能会
加倍。您的无线网络的范围取决于很多因素，包括您的路由器和网络适配器的能力。如果您在打印时遇到问
题，请尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

您可以在网络设置页中找到网络的信号强度。

检查 MAC 地址

如果您的网络使用了 MAC 地址过滤功能，请确认将打印机的 MAC 地址添加到 MAC 地址过滤列表中，可
以允许打印机在网络中使用。
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在安装过程中，Wi-Fi 指示灯闪烁橙色

当 Wi-Fi 指示灯闪烁橙色时，表示打印机已经过无线网络设置，但是无法连接到配置打印机的网络。打印机可
能因为干扰或者距离无线接入点（无线路由器）太远而无法加入网络，或者需要改变打印机设置。

请尝试其中的一种或多种方法：

确认接入点的电源已打开

请检查接入点，如有必要，请打开电源。

移动您的接入点，以便干扰最小

其他设备（例如微波或其他用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干扰。请确
认您的接入点没有放置在距离这些设备很近的地方。

将计算机和／或打印机移动到距离接入点比较近的地方

802.11b 或 802.11g 网络中的设备之间的距离可以达到 300 英尺，而 802.11n 网络的无线网络范围可能会
加倍。您的无线网络的范围取决于很多因素，包括您的接入点和无线网络适配器的能力。如果您在打印时遇
到问题，请尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

您可以在网络设置页中找到网络的信号强度。

检查您的 WEP 密钥或 WPA 密钥

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的 ASCII 字
符需要区分大小写。

注意：如果您不知道此信息，请参阅随同无线网络一起提供的帮助文档，或者与安装您的无线网络的人员联
系。

检查 MAC 地址

如果您的网络使用了 MAC 地址过滤功能，请确认将打印机的 MAC 地址添加到 MAC 地址过滤列表中，可
以允许打印机使用网络。请参阅第 104 页“我如何查找 MAC 地址？”获取更多的信息。
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使用 PING 命令测试接入点，确认网络可以正常工作

Windows 用户

1 获取接入点的 IP 地址。

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 cmd。

c 按 Enter 键，或者单击“确定”。

d 输入 ipconfig，然后按 Enter 键。

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

2 使用 Ping 命令测试接入点：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 cmd。

c 按 Enter 键，或者单击“确定”。

d 输入 ping，一个空格，然后输入接入点的 IP 地址。例如：

ping 192.168.1.100

e 按 Enter 键。

3 检查接入点是否有回应：

• 如果接入点有回应，您将会看到几行以 Reply from（回复自）开头的文字。

可能是打印机没有连接在无线网络中。请关闭并重新启动打印机，然后重新尝试连接。

• 如果接入点没有回应，您将会看到 Request timed out（请求超时）文字。

请尝试以下的方法：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 ncpa.cpl。

c 按 Enter 键，或者单击“确定”。

d 从显示的列表中选择适当的连接。

e 右键单击连接，然后单击“修复”或“诊断”。

Macintosh（英文版）用户

1 请确认 AirPort 已启用：

从 Apple 菜单中依次选择：

System Preferences > Network

AirPort 状态指示灯应该是绿色的。

问题解答
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注意：

• 黄色表示端口可用，但是没有连接。

• 红色表示端口没有配置。

2 获取接入点的 IP 地址：

a 从 Apple 菜单中依次选择：

About This Mac > More Info

b 在 Contents 区域中单击 Network。

c 从 Active Services 列表中选择 AirPort。
底部区域中列出了 AirPort 连接的详细信息。

d 记录下 Router（路由器）项目。

Router（路由器）项目通常即为接入点。

3 使用 Ping 命令测试接入点：

a 从 Finder 中依次选择：

Utilities > Network Utility > Ping 选项卡

b 在网络地址区域中输入接入点的 IP 地址。例如：

10.168.1.101

c 单击 Ping。

4 如果接入点有回应，您将会看到几行文字，显示从接入点接收到的字节数。这表示您的计算机连接在接
入点上。

如果接入点没有回应，则不会显示任何文字。您可以使用 Network Diagnostics 帮助您解决问题。

请确认您的计算机可以和打印机进行通讯

Windows 用户

1 获取打印机的 IP 地址。

a 从打印机打印一张网络设置页。

如要获取更多的信息，请参阅用户手册。

b 在 TCP/IP 区域中查找“地址”。

2 单击 ，或者单击“开始”，然后单击“运行”。

3 在“开始搜索”或“运行”框中输入 cmd。

4 按 Enter 键，或者单击“确定”。

5 输入 ping，一个空格，然后输入打印机的 IP 地址。例如：

ping 192.168.1.100

6 按 Enter 键。

7 如果打印机有回应，您将会看到几行文字，显示从打印机接收到的字节数。这可以确定您的计算机可以
和您的打印机进行通讯。

如果打印机没有回应，您将会看到 Request timed out（请求超时）文字。

• 您的计算机可能没有连接在网络中。

• 您可能需要改变您的打印机的设置。请重新运行无线设置应用程序。

问题解答
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Macintosh（英文版）用户

1 获取打印机的 IP 地址。

a 从打印机打印一张网络设置页。

如要获取更多的信息，请参阅用户手册。

b 在 TCP/IP 区域中查找“地址”。

2 从 Finder 中依次选择：

Utilities > Network Utility > Ping 选项卡

3 在网络地址区域中输入打印机的 IP 地址。例如：

10.168.1.101

4 单击 Ping。

5 如果打印机有回应，您将会看到几行文字，显示从打印机接收到的字节数。这表示您的计算机可以和您
的打印机进行通讯。

如果打印机没有回应，则不会显示任何文字。

• 您的计算机可能没有连接在网络中。您可以使用 Network Diagnostics 帮助您解决问题。

• 您可能需要改变您的打印机的设置。请重新运行 Wireless Setup Assistant。

重新进行无线设置

如果您的无线设置已经改变了，您必须重新进行打印机无线设置。WEP 或 WPA 密钥、频道或其他网络设
置可能被手动改变了；或者接入点可能被恢复为出厂默认设置。

重新进行无线设置也可以解决由于无线配置错误所引起的问题。

注意：

• 如果您要改变网络设置，请先在所有的网络设备上改变设置，然后再改变接入点的设置。

• 如果您已经在接入点上改变了无线网络设置，您必须在所有其他的网络设备上改变设置，然后才可以在
网络中看到这些设备。

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

注意：在安装过程中，可能会提示您使用安装电缆再次将打印机连接在计算机上。

4 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。
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没有安装无线打印服务器

在安装过程中，您可能会看到一条信息，提示您打印机没有安装无线打印服务器。如果您不确定打印机是否可
以进行无线打印，请尝试以下的方法：

检查电源

请确认  指示灯亮着。

当进行无线打印时出现“无法通讯”信息

请尝试其中的一种或多种方法：

请确认您的计算机和打印机都有适合于网络的有效 IP 地址

如果您使用的是便携式笔记本电脑，并且启用了节约能源设置，当您尝试进行无线打印时，您可能会在笔记
本电脑的屏幕上看到“无法通讯”信息。如果笔记本电脑的硬盘驱动器处于节约能源模式，此情况将会发
生。

如果您看到了此信息，请等待几秒钟，然后重新尝试打印。笔记本电脑和打印机需要几秒钟的时间才可以恢
复正常模式并重新连接到无线网络。

如果您等待了足够长的时间让笔记本电脑和打印机连接到网络，但是仍然看到了此信息，可能是您的无线网
络出现了问题。

请确认笔记本电脑和打印机都接收到了 IP 地址：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中单击 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

Router（路由器）项目通常即为接入点。
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查找打印机的 IP 地址

• 从打印机打印一张网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

1 在打印机操作面板上依次选择：

 > 网络设置 > TCP/IP

2 查找“IP地址”。

如果打印机和／或笔记本电脑没有 IP 地址，或者 IP 地址是 169.254.x.y（其中 x 和 y 是 0–255 之间的任意
两个数字）：

1 关闭没有有效 IP 地址的设备（笔记本电脑、打印机、或者全部）。

2 打开设备，然后重新检查 IP 地址。

如果笔记本电脑和／或打印机仍然没有接收到有效的 IP 地址，可能是您的无线网络出现了问题。请尝试以
下的方法：

• 请确认您的接入点（无线路由器）的电源已打开，并且可以正常工作。

• 移开所有可能阻止信号的物体。

• 临时关闭您的网络中所有不必要的无线设备，并暂停所有的密集网络活动，例如文件传输或网络游戏。
如果网络太忙，打印机有可能在允许的时间内没有接收到 IP 地址。

• 请确认您的 DHCP 服务器（也可能是您的无线路由器）可以正常工作，并且经过了配置，可以分配 IP
地址。如果您不确定如何操作，请参阅随同您的无线路由器一起提供的帮助文档。

如果打印机和计算机都有有效的 IP 地址，并且网络工作正常，请继续进行问题解答操作。

请确认您选择了无线端口

注意：此方法只适用于 Windows 用户。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 找到当前的端口。在“端口”区域中，当前的端口前面有一个选中标记。

7 如果当前端口的“描述”区域中表明它是一个 USB 端口，请从列表中选择“描述”区域是“打印机端
口”的端口。请检查“打印机”区域中的打印机型号，确认您选择了正确的打印机端口。

8 单击“确定”，然后重新尝试打印。

请确认双向通讯已启用

注意：此方法只适用于 Windows 用户。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。
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4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 选中“启用双向支持”。

7 单击“应用  > 确定”，然后重新尝试打印。

当连接到虚拟个人网络(VPN)时与打印机的通讯中断了

当您连接到大多数虚拟个人网络(VPN)时，与您的本地网络中的无线打印机的连接将会中断。大多数 VPN 只
允许用户与 VPN 进行通讯，不可以同时与其他网络进行通讯。如果您希望可以同时连接到您的本地网络和
VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling（分离通道）功能。请注意，一些机构组织出于
安全或技术的原因不允许使用此功能。

解决间歇无线通讯问题

尽管您的无线网络中明显没有任何改变，您可能会注意到您的打印机工作了一小段时间，然后停止了工作。

很多不同的问题可以中断网络通讯，并且有时多个问题同时存在。请尝试其中的一种或多种方法：

当您尝试使用无线网络时，请从所有的 VPN 上断开连接

大多数虚拟个人网络(VPN)只允许计算机与 VPN 进行通讯，不可以同时与其他网络进行通讯。在计算机上
安装驱动程序或者在计算机上运行无线设置之前，请从 VPN 上断开连接。

如要检查计算机现在是否连接在 VPN 中，请打开您的 VPN Client 软件并检查您的 VPN 连接。如果您没有
安装 VPN Client 软件，请使用 Windows VPN Client 手动检查连接。

如果您希望可以同时连接到您的本地网络和 VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling
（分离通道）功能。请注意，一些机构组织出于安全或技术的原因不允许使用此功能。

关闭接入点（无线路由器）的电源，然后重新打开

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接并解决连接问题。

消除网络拥堵

如果无线网络太忙，计算机和打印机可能很难互相通讯。导致无线网络拥堵的原因可能包括：

• 通过网络传输很大的文件

• 网络游戏

• 点对点文件交换应用程序

• 流视频

• 无线网络中同时存在太多的计算机

消除干扰源

普通家庭用品有可能会中断无线网络通讯。位于无线网络附近的无线电话（不包括手机）、微波炉、婴儿监
视器、几乎所有的厨房用具、无线监视设备以及任何包含发动机的用具都有可能会中断无线网络通讯。

请尝试打开这些可能的干扰源，看它们是否导致了问题。如果是，请将您的无线网络与这些设备分开。
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改变接入点使用的频道

有时候您可以通过改变您的接入点用于广播的频道来消除来自未知来源的干扰。路由器上有 3 个独特的频
道。请参阅随同您的路由器一起提供的帮助文档确定是哪三个。其他的频道作为可选项提供，但是它们是互
相交迭的。如果路由器配置为使用默认设置，请改变频道设置，使用不同的独特频道。如果您不确定如何改
变频道，请参阅随同您的接入点一起提供的帮助文档。

使用唯一的 SSID 配置接入点

很多无线网络使用路由器制造商最初为路由器配置的 SSID。当使用相同 SSID 的多个网络在同一个区域内
共同工作时，使用默认的 SSID 可能会导致出现问题。尽管会显示正在尝试连接到正确的网络，但是打印机
或计算机可能会尝试连接到错误的网络。

如要避免出现这种类型的干扰，请在您的接入点上改变 SSID，不要使用默认值。如果您不确定如何改变
SSID，请参阅随同您的接入点一起提供的帮助文档。

注意：如果您在接入点上改变了 SSID，您必须在所有访问您的无线网络的其他设备上改变 SSID。

为网络中的所有设备指定静态 IP 地址

大多数无线网络使用无线路由器内置的 DHCP（动态主机分配协议）服务器为无线网络中的用户分配 IP 地
址。DHCP 地址在需要的时候才会分配，例如当新的设备添加到无线网络中或者当设备打开电源时。无线设
备必须向路由器发送请求，然后接收一个 IP 地址，以便可以在网络中工作。由于无线路由器除了分配地址
以外还要完成很多其他的任务，有时可能不会很快地响应并分配地址。请求的设备有时会在接收到地址之前
就放弃了。

请尝试为您的网络中的设备指定静态 IP 地址以解决此问题。

如要为打印机指定一个静态 IP 地址：

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

在网络浏览器的地址栏中输入静态 IP 地址并查看打印机网页是否可以打开，以确认 IP 地址是否已更新。如
要获取更多有关指定静态 IP 地址的帮助信息，请参阅随同您的路由器和操作系统一起提供的帮助文档。

查看接入点的已知问题

一些无线路由器带有明确的缺陷，已经得到了制造商的验证和确认。请访问路由器制造商的公司网站。从制
造商了解固件升级信息和其他的建议。如果您不确定如何访问制造商网站，请参阅随同您的无线路由器一起
提供的帮助文档。

检查无线网络适配器升级

如果您从一台特别的计算机打印时遇到了问题，请查看计算机中的无线网络适配器卡的制造商网站。网站上
可能有升级的驱动程序，可以解决问题。
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将所有的网络设备改变为相同的类型

虽然在同一个无线网络中可以成功地同时包含 802.11b、802.11g 和 802.11n 设备，但是较快的设备有时会
阻止较慢的设备进行通讯。

请尝试只打开相同类型的网络设备，看网络通讯是否有所改善。如果此方法可以解决问题，您可能需要使用
较新的无线网络适配器升级您的较旧的设备。

购买一个新的路由器

如果您的路由器已经使用了很多年，它可能无法与您的网络中较新的无线设备完全兼容。请考虑购买一个可
以完全兼容 802.11 IEEE 规范的较新的路由器。

问题解答
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通告

产品信息

产品名称：

Dell V515 Series

机器类型：

4443

型号：

2dw, 6dw

版本通告

2010 年 8 月

本手册中可能会有技术上的不准确或印刷错误。鉴于此，本手册中的内容会阶段性地更新；这些改动将会体现
在以后的版本中。产品或程序有可能会随时改动，如有改动，恕不另行通知。

许可注意事项

下列文档可以从安装软件 CD 查看。

目录 文件

CD:\LEGAL FW_License.pdf

mDNS.tar.gz

Expat.txt

Inst_lib.txt

Instgui.txt

Instgui.zip

噪声等级

以下的测量是依照 ISO 7779 进行的，并且所做的报告完全符合 ISO 9296 的标准。

注意：一些模式可能不适用于您的产品。

1 米平均声压（分贝）

打印 40 dBA

扫描 50 dBA

复印 40 dBA

通告

147



1 米平均声压（分贝）

准备就绪 无声

温度信息

工作环境温度 15–32°C（60–90°F）

运输温度 -40–60°C（-40–140°F）

储存温度 1–60°C（34–140°F）

产品处理

请勿按处理日常生活垃圾的方法来处理打印机或消耗品。请咨询您当地的权威机构以了解处理和回收选项。

电池通告

此产品包含高氯酸盐材料，可能需要特殊的处理方法。请访问网站
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/获取更多的信息。

中国 RoHS 计划的信息

部件名称 有毒及有害物质或元素

铅（Pb）汞（Hg）镉（Cd）六价铬（Cr VI）多溴联苯（PBB）多溴二苯醚（PBDE）

电路板 X O O O O O

电源 X O O O O O

电源线 X O O O O O

连接器 X O O O O O

机械配件—杆、辊 X O O O O O

机械配件—电机 X O O O O O

机械配件—其他 X O O O O O

扫描仪配件 X O O O O O

LCD 显示屏 X O O O O O

O：表示部件的所有同质材料中有毒和有害物质的含量低于 SJ/T11363-2006 中描述的浓度限制要求。

X：表示部件中至少一种同质材料中的有毒和有害物质含量高于 SJ/T11363-2006 中描述的浓度限制要求。

此产品符合欧盟指令 2002/95/EC 中有关某些有害物质使用的限制。
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能源消耗

产品能源消耗

下面的表格列出了此产品在各种模式下的能源消耗特性。

注意：一些模式可能不适用于您的产品。

模式： 说明： 耗电量（瓦特）：

打印 产品正在打印电子文档。 16

复印 产品正在使用文档原件复印副本。 11

扫描 产品正在扫描文档原件。 9.37

准备就绪 产品正在等待打印作业。 6.95

节约能源 产品处于节约能源模式。 3.7

关闭 产品连接在电源插座上，但是电源开关是关闭的。0.37

上面表中所列出的能源消耗数值是基于时间的平均测量结果。某一时刻的实际能源消耗可能会比平均值高。

省电模式

本产品被设计为使用一种称为“省电模式”的能源节省模式。“省电模式”相当于“睡眠模式”。“省电模
式”通过在长期不活动时间内减少电力消耗来节约能源。本产品在指定时间段（称为“省电模式超时”）未被
使用后自动进入“省电模式”。

本产品的出厂默认“省电模式超时”（以分钟为单位）： 10

通过使用配置菜单，可以在 1 分钟至 240 分钟之间修改“省电模式超时”。将“省电模式超时”设置为较低
的值可以减少能源消耗，但是可能会增加产品的响应时间。将“省电模式超时”设置为较高的值可以保持较快
的响应速度，但是会使用更多的能源。

关闭模式

此产品有一种关闭模式，仍然会消耗很小量的能源。如要使产品完全不消耗能源，请从电源插座上断开电源
线。

能源消耗总量

有时候计算此产品所消耗的能源总量是非常有用的。因为能源消耗声明是以 Watts（瓦特）作为单位的，因
此，如要计算实际消耗的能源总量，还应该分别乘以此产品在各种模式下所工作的时间。将各种模式下所消耗
的能源加在一起，就是此产品所消耗的能源总量。

通信终端设备管制通告

本章包含有关通信终端设备产品（例如传真机）的管制信息。
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无线产品管制通告

本章包含以下有关无线产品（包括但不限于发射机、无线网卡或感应式读卡器）的管制信息。

无线频率辐射暴露通告

此设备的辐射输出能量远远低于美国通信委员会(FCC)和其他管制机构有关无线频率辐射暴露的限制。此设备
的天线和操作人员之间的距离必须保持至少 20 厘米（8 英寸），以满足 FCC 和其他管制机构有关无线频率辐
射暴露的要求。

Notice to users in Brazil
Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference
that may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly
prohibited per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit
RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne
est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.
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Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement
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A
Ad hoc 

SSID（服务设置识别码）  89
WEP  89

Ad hoc 网络  100
Ad hoc 无线网络 
使用 Macintosh（英文版）创
建  89

使用 Windows 创建  89
添加打印机  92

AliceBox  88
安全密钥  97
安全信息  7
安全性 
无线网络  85

安全性信息 
无线网络  97

安装 
电缆  99
网络打印机  105

安装传真 
DSL 连接  65
VoIP 连接  66
标准电话线连接  62
国家或地区特定  68
数字电话服务  67

安装后改变无线设置（Macintosh
英文版）  89
安装后改变无线设置
（Windows）  89
安装可选的软件  24
安装问题解答 
打印机打印出空白页  114
打印机没有反应  114
打印头错误  110
软件不能安装  112
无法通过 USB 进行打印  115
显示屏上的文字是错误的语
言  110

页面不能打印  113
按钮，打印机操作面板 
拨号音  17
彩色／黑白  17
传真  16
电源  16
返回  17
复印  16
开始  17

取消  18
扫描  16
设置  17
数字符号键区  18
通讯簿  17
显示屏  16
选择  17
照片  16

B
保存纸张默认设置  30
报告 
传真历史记录  83

报告，传真 
设置  73

标签纸  29
打印  36

拨号方法，传真 
设置  73

拨号前缀  80
拨号音 
检查  81

拨号音量 
调整  81

部件 
PictBridge 接口  11
USB 接口  12
Wi-Fi 指示灯  11
安全孔  12
出纸托盘  11
存储卡插槽  11
打印机操作面板  11
打印头  12
电源插口  12
顶盖  12
进纸保护盖  11
进纸导轨  11
扫描仪玻璃  12
扫描仪部件  12
双面打印部件  11
纸张支架  11
自动文档传送器(ADF)  11
自动文档传送器(ADF)进纸导
轨  11

自动文档传送器(ADF)输出托
盘  11

自动文档传送器(ADF)输入托
盘  11

C
Club Internet  88
插入存储卡后没有任何反应  128
插入存储卡或闪存驱动器  38
查看墨水量  106
查找 

MAC 地址  104
SSID（服务设置识别码）  96
WEP 密钥  96
WPA 密钥  96
出版物  9
网站  9
信息  9

尝试重拨次数，传真 
设置  73

重拨时间，传真 
设置  73

出版物 
查找  9

出厂默认设置 
恢复  20
恢复内部无线打印服务器  130

出纸托盘  11
传输报告，传真  83
传真 
拨号前缀  80
传送报告  83
打印机内存  84
电话卡，使用  83
定时  82
何时应答  80
立刻发送群组传真  77
铃声  80
确认页  83
设置  79
使用操作面板  77
使用操作面板发送  77
使用计算机  77
手动接收  78
特色铃声  80
提示，发送  77
提示，接收  78
通讯簿  75
自动接收  78
阻止  84

传真错误信息 
不可恢复的传真错误  127
不支持的传真模式  126
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不支持的分辨率  127
不支持的压缩  127
传真调制解调器错误  127
电话线连接在机器后面错误的插
座上  127

电话线路错误  127
电话线路忙  127
电话线没有连接  127
检测到数字线路  127
连接失败  127
没有来电号码  127
无应答  127
远程传真错误  126

传真打印 
设置  73

传真发送速度 
设置  73

传真分辨率 
设置  82

传真号码  80
传真活动报告  83
传真设置 

DSL 连接  65
VoIP 连接  66
标准电话线连接  62
电话答录机  82
国家或地区特定  68
配置  73, 74
数字电话服务  67
语音邮件  82

传真设置向导  74
传真设置应用程序  74
传真提示 
手动接收传真  78
自动接收传真  78

传真问题解答 
错误信息，打印机操作面
板  126

无法发送传真  123
无法接收传真  125
无法运行传真软件  126

传真问题解答注意事项  122
传真页脚 
设置  73

传真页眉 
设置  73

传真页眉和页脚 
设置  72

传真质量 
设置  82

传真转发  84

从 USB 转换 
到无线  93

从无线转换 
到 USB  93

存储卡 
插入  38
打印文档  35
扫描至  57
使用样张页打印照片  42
支持的类型  39

存储卡插槽  11
存储卡问题解答 
插入存储卡后没有任何反
应  128

无法从闪存驱动器中打印  128
注意事项  128

存储卡无法插入  128
存储设备中的照片 
使用打印机软件打印  40

错误修正，传真 
设置  73

D
DSL 过滤器  65
打印 
标签纸  36
从 PictBridge 兼容数码相机
中  41

从存储卡或闪存驱动器中打印文
档  35

从蓝牙设备中  45
倒序打印  33
将多页文档复印到一张纸上  34
使用 DPOF 从数码相机中打印照
片  43

使用打印机操作面板打印照
片  39

使用打印机软件打印存储设备中
的照片  40

使用样张页打印照片  42
双面打印  46
提示  32
网络设置页  86
文档  32
先打印最后一页  33
信封  36
在纸张的双面  46
逐份打印  33
自定义尺寸的纸张  37

打印的图像中出现条纹或线
条  119

打印发送报告  83
打印机 
共享  94
在 Windows 环境下共享  94

打印机，设置为默认  48
打印机不打印 
无线  135

打印机不能复印或扫描或者没有反
应  120
打印机不能无线打印  135
打印机操作面板  11
使用  16

打印机打印出空白页  114
打印机的外壳 
清洗  108

打印机没有反应  114
打印机内存 
传真  84

打印机内发生卡纸  115
打印机软件 
反安装  25

打印机问题，基本解决方法  109
打印介质 
标签纸  29
贺卡  29

打印模式 
改变  48

打印墨盒 
订购  13
更换  13

打印确认页  83
打印速度慢  119
打印头  12
校正  106

打印头错误  110
打印头喷头 
清洗  107

打印问题解答 
打印的图像中出现条纹或线
条  119

打印速度慢  119
打印页边缘处的打印质量非常
差  118

当打印时计算机速度变慢  120
无法从打印队列中删除文
档  114

打印页边缘处的打印质量非常
差  118
打印作业 
继续  50
取消  50
暂停  49
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当打印时计算机速度变慢  120
倒序打印  33
电话簿 
设置  75

电话插头  68
电话答录机 
设置  62
最佳传真设置  82

电话分线器  66
电缆 

USB  99
安装  99

电源插口  12
电子邮件 
扫描的文档  59

顶盖  12
定时传真 
发送  82

多个 WEP 密钥  105

E
Electronic emission notices（电
磁兼容声明）  147, 150

F
FCC notices  150
FreeBox  88
发件人信息 
注册  72

发送报告，传真  83
发送传真，提示  77
发送定时传真  82
发送历史记录报告  83
法国 
特殊的无线安装指导  88

反安装打印机软件  25
放大图像  53
分线器，选择  79
复印  52
放大图像  53
复制图像  54
将多页文档打印到一张纸上  54
进行复印  52
每张纸上打印多页  54
使复印结果较浅或者较深  53
缩小图像  53
提示  52
调整质量  53
在纸张的双面  55
照片  52
逐份打印  54

复印和扫描问题解答 
打印机不能复印或扫描或者没有
反应  120

扫描不成功  121
扫描的质量非常差  120
扫描任务花费很长的时间或者导
致死机  121

文档或照片只扫描了一部
分  121

无法通过网络扫描至计算
机  122

复印问题解答 
扫描仪部分没有关闭  120

复印质量，调整  53
复印作业 
取消  55

复制图像  54

G
改变打印模式  48
改变节约能源时限  19
干扰 
无线网络  101

更换打印墨盒  13
更新应用程序列表  60
共享打印  95

H
合并打印  54
贺卡  29
黑白扫描  60
横幅纸  28
恢复 
将内部无线打印服务器恢复为出
厂默认设置  130

恢复出厂默认设置  20
回收  8

Dell 产品  15

I
Infrastructure 网络  100
IP 地址  104
配置  89

IP 地址，指定  105
IP 语音(VoIP) 
传真设置  66

J
计算机上的防火墙  135
技术支持  109

继续 
打印作业  50

“继续”按钮不能工作  134
“继续”按钮是灰色的  134
“继续”按钮无法使用  134
检查拨号音  81
检查无反应的打印机  109
将临时设置改变为默认设置  18
校正打印头  106
接收传真 
手动  78
提示  78
自动  78
自动应答设置  78

接收历史记录报告  83
节约能源、墨水和纸张  8
节约能源时限 
改变  19

节约纸张 
使用经济模式  19

进纸保护盖  11
进纸导轨  11
禁用设置时限  18
经济模式 
使用  19

K
卡纸和进纸错误问题解答 
打印机内发生卡纸  115
纸张或特殊介质进纸错误  117
纸张支架内发生卡纸  116
自动文档传送器(ADF)内发生卡
纸  116

快速拨号 
设置  75

L
LiveBox  88
垃圾传真 
阻止  84

来电显示  72
来电显示模式，传真 
设置  73

蓝牙 
打印  45
设置安全等级  45
设置连接  43

连接 
配置  103

联系人列表 
设置  75
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临时设置 
改变为默认设置  18

铃声音量 
调整  81

M
Macintosh（英文版）打印机软件 
使用  23

MAC 地址  103
查找  104

MAC 地址过滤  103
没有无线网络  89
密码  97
密钥索引  105
免提传真  83
明信片  29
墨水 
节约  8

墨水量 
查看  106

默认打印机，设置  48
默认值 
恢复出厂默认设置  20

N
N9UF Box  88
内部无线打印服务器 
恢复出厂默认设置  130

能源 
节约  8

P
PDF 
从扫描结果创建  59

PictBridge 兼容数码相机 
连接  41

PictBridge 接口  11
配置 

IP 地址  89
传真设置  73, 74

普通纸  28

Q
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